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Important Information

Thank you for purchasing the GCC Jaguar IV Cutting Plotter.
Before you use the cutting plotter, please make sure that you have read the
safety precautions and instructions below.

JAN

Caution SAFETY PRECAUTIONS!

> For safety concern, please always hold the cutter firmly from the bottom while moving

it. Do not move the cutter by clasping the depression area on both sides.

O (Correct) X (Incorrect)

> Do not shake or drop the blade holder, a blade tip can fly out.

> During an operation, do not touch any of the moving parts of this machine (such as the
carriage). Also be careful to make sure that clothing and hair do not get caught.

> Always connect the power cable to a grounded outlet.

> Always use the accessory power cable which is provided. Do not wire the power cable
so that it becomes bent or caught between objects.

> Do not connect the power cable to branching outlet to which other machines are also
connected, or use an extension cable. There is danger of overheating and of

mis-operation of the machine.
> Keep the tools away from children where they can reach.

> Always put the pinch rollers within the white marks.

Important Information
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Warning

Never press the top release grip and pull the bottom release grip at the same time as

the pictures shown below:

O (CORRECT) X (INCORRECT)

Press down Press down

Stop bar

Note:

In case the grips clipped
together due to your
wrong operation, please
use a tweezers to pull

out the stop bar when

pressing down the top

Pull up bottom to release grip
release grip. Keep the

ENABLE I stop bar outside then
release the grips as the

right figure.

Important Information
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1. General Information

1.1 Introduction
Jaguar IV series cutting plotters have been designed to produce computer-generated images
or perform contour cutting on sheets or rolls of vinyl media.

This manual covers the following models of Jaguar IV series cutting plotters:

- J4-61 for media width: 50mm(1.97”) ~ 770mm(30.3")

+ J4-101S for media width: 50mm(1.97") ~ 1270mm(50")

- J4-132S for media width: 50mm(1.97") ~ 1594mm(62.7")
- J4-183S for media width: 300mm(11.8") ~ 1900mm(74.8")

1.2 Package Iltems
The package of the Jaguar IV model contents the items listed below, please check carefully.
If you find any item missing, please consult your local dealer for further assistance.

Standard Item Quantity

1. Cutting Plotter 1

2. Stand Set (for J4-101S/132S/183S only )(Optional for J4-61)
® 2 piece of T-shape stand

1 piece of stand beam

18 pieces of M6 screws

1 piece of M5 L-shape hexagon screw driver

1 piece of Installation Guide for Stand Set

3. Flexible Media Support System Package
Items 183S/132S/101S

1 set of Roll Media Flange (2 pieces) \
1 set of Roll Holder (2 pieces)

1 set of Roll Holder Guide Bushes (4 pieces)
1 set of Roll Holder Support (2 pieces)

1 piece of M6 L-shape hexagon screw driver
1 piece of Installation Guide for Roll Holder

(o]
=

<< K<<

1 piece of M5 L-shape hexagon screw driver

1 set of Desktop Support Brackets (2 pieces)
4 pieces of Plastic Foot

4 pieces of M4 screws

12 pieces of M6 screws

1 piece of M4 L-shape hexagon screw driver

NENENENEGIEGENE YNNG RN
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4. Accessories

1 piece of User’s Compact Disk

1 piece of AC power Cord

1 piece of data cable (RS-232C)
1 piece of data cable (Print cable)
1 piece of data cable (USB cable)
1 set of Blade Holder Assembly (Installed in tool carriage of the cutting 1
plotter)

1 piece of Blade (Installed in Blade Holder)
1 piece of Safe Blade

1 piece of Cutting Pad for Vinyl cutting

1 piece of Tweezers

1 piece of Promise Card

1.3 Product Features

The following are the main features of the Jaguar IV series cutting plotters:

Tri-port connectivity provides you with greater flexibility

Up to 600-gram cutting force

Up to 60-inch/per second cutting speed

Guaranty 10-meter tracking

User friendly, multi-language control panel

Ingenious media basket (optional item)

Enhanced Accu-Aligning System for automatic contour cutting

General Information 1-2
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1.4 Appearance of Jaguar IV

1.4.1  The Front View (Figure 1-1)

Grid Drums - move
the media back and

forth during operation.
Tool Carriage - performs the

cutting with the installed blade

and pen with AAS module.

Control panel - consists of 14
control keys and 1 LED and 1 LCM

showing messages and menus.

Slicer Groove -
slice off the extra

media easily along

this groove.

Alignment Rulers -

Platen - provides the

. media can be aligned Cutting Pad - provides the
surface for holding and
. . . with the clear guide line protection of blade when the blade is
supporting media while
. . marks. cutting.
performing cutting.
Figure 1-1

142 The Back View (Figure 1-2)

Lever -
raises or lowers the

pinch rollers.

Pinch Rollers -
hold the media during

cutting.

Figure 1-2
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1.43 The Whole View of Jaguar IV (Figure 1-3)

Roll Holder
Support - supports

roll holders.

T-Stand -supports
the cutting plotter

Stand Beam -
stabilizes the body.

Roll Holder - holds
and supplies the roll

media for cutting.

Figure 1-3

Roll Holder Guide

Bushes - serve to

keep the roll media in
place when media is

pulled from the roll.

T-Stand -supports
the cutting plotter

General Information
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1.44  The Left-hand Side (Figure 1-4)

Power Switch — On when switches to [I]; Off to [O]

Figure 1-4

Fuse — 3 Amp.

AC Power Connector — used to insert the AC power cord.

1.45 The Right-hand Side (Figure 1-5)

Serial Interface Connector (RS232C) — used

to connect the cutting plotter to a computer
through a serial interface cable.

USB Connector - used to connect the cutting
plotter to a computer through a USB cable.

Parallel Interface Connector — used to connect

. the cutting plotter to a computer through a
Figure 1-5 _ gp P J
parallel interface cable.

General Information 1-5
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2. Installation

2.1 Precaution
Please read below information carefully before you start installation.

Notice 1
e Make sure the power switch is off before installing the cutting plotter.

e Carefully handle the cutter to prevent any injuries.

Notice 2 Choosing a proper place before setting up the cutting plotter

Before installing your cutting plotter, select a suitable location, which meets the following
conditions.

e The machine can be approached easily from any direction.

e Keep enough space for the machine, accessories and supplies.

e Keep the working area stable, avoiding sever vibration.

e Keep the temperature between 15 and 30 T (60-86°F) in the workshop.

e The relative humidity of the working environment should be between 25% to 75%.
e Protecting the machine from dust and strong air current.

e Preventing the machine from direct sunlight or extremely bright lighting.

Notice 3 Connecting the Power Supply

Check the plug of the power cord to see if it matches with the wall outlet. If not, please contact
your dealer.

e Insert the plug (male) into a grounded power outlet.

e Insert the other end (female) of power cord into the AC connector of cutting plotter.

Installation 2-1
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2.2 Stand & Flexible Media Support System (for J4-101S/132S/183S)

Step 1
Please examine supplied items in the accessory box of stand carton:
e 2 piece of T-shape stand

1 piece of stand beam

18 pieces of M6 screws

1 piece of M5 L-shape hexagon screw driver
1 piece of Installation Guide for Stand Set

Step 2
e Remove the plotter body and the accessories from the shipped carton.

e Place the stand beam upright on the T-stand and follow the number @ @® to
assemble.

(See Figure 2-1 & 2-2)

® stand beam

Figure 2-1

Figure 2-2

Installation 2-2
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Step 3

Position the stand beam perpendicularly to part Oand put the screws into the holes and
tighten them as Figure 2-2. Then the complete picture of stand will be like Figure 2-1.

Step 4
Remove the cutting plotter from the carton. Position your stand under the plotter, and then

insert the screws into the holes on plotter’s bottom and tighten them up as shown in Figure
2-3.

Screws

Figure 2-3

Installation 2-3
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Step 5
Insert the roll holder support with the screws into the holes of the stand, and then tighten them

up as shown in Figure 2-4. You could decide roll holder support’s position by inserting into
different holes.

3 screws

Roll holder

Figure 2-4

Step 6
Place two roll holders into the holes in the roll holder support. (Figure 2-5)

Roll holder support

Roll holders

Figure 2-5

Installation 2-4
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Step 7
Lastly, the complete picture will be shown like below. (Figure 2-6)

Figure 2-6

Installation 2-5
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2.3 Desktop Flexible Media Support System (For J4-61 only)

Step 1
Please examine the following items in stand carton’s accessory box:

1 set of Roll Media Flange (2 pieces)

1 set of Roll Holder (2 pieces)

1 set of Roll Holder Guide Bushes (4 pieces)
1 set of Roll Holder Support (2 pieces)

1 set of Desktop Support Bracket (2 pieces)
4 pieces of Plastic Foot

4 pieces of M4 screws

12 pieces of M6 screws

1 piece of M4 L-shape hexagon screw driver
1 piece of M5 L-shape hexagon screw driver
1 piece of M6 L-shape hexagon screw driver (for adjusting the screws of Roll Holders)
1 piece of Installation Guide for Roll Holder

Step 2
Put the 4 Plastic Foot under the Roll Holder Support and insert the M4 screw into the hole of
Plastic Foot and tighten them with the M4 L-shape screw driver. (Figure 2-7)

Figure 2-8
Roll Holder Support

Roll Holder Support

M6 screws

Plastic

M4 screws Desktop Support Brackets
Figure 2-7
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Step 3  Position the Desktop Support Brackets beside the Roll Holder Support and insert
M6 screws into the Roll Holder Support and tighten them with M6 L-shape screw driver. (Refer
to Figure 2-8 at the left).

Step 4

Put the bottom of machine in lateral, and position the Roll Holder Assembly beside the bottom
of the machine. Then, insert the M6 screws into the holes of Roll Holder support assembly
and tighten them with M6 L-shape screwdriver. Like Figure 2-9.

M6 screws
Screw holes

Roll Holder Assembly

Figure 2-9
Roll Holders Figure 2-10

Step 5
Place the two roll holders into the holes of Roll Holder Support (Figure 2-10).

Step 6
The complete Desktop Media Support System will be shown as in Figure 2-11.

Figure 2-11

Installation 2-7
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2.4 Blade Installation
Figure 2-12 is the illustrator of the blade holder. Insert a blade into the bottom of the blade
holder and remove the blade by pushing the pin. Make sure that your fingers are away from

the blade tip.
9 Pin

Adjustment depth knob

Outward ring /

Figure 2-12

Step 1
Install blade (Figure 2-13).

Figure 2-13 Figure 2-14
Step 2
Push the blade to the bottom of the blade holder. (Figure 2-14).

Step 3

Adjust the blade tip to suitable length by screwing
“Blade tip adjustment screw” clockwise or

count-clockwise. (Figure 2-15).

Tips:

“The proper length” means the blade’s

length is adjusted 0.1mm more than

film’s thickness. That is, if the thickness

of film is 0.5mm, then blade’s length is
properly adjusted 0.6mm and it can
completely cut through the film layer yet
avoid penetrating the backing.

Figure 2-15

Installation 2-8
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Step 4
Insert the blade holder into tool carriage. Please note the outward ring of the holder must put
into the grooves of carriage firmly

Figure 2-16 Figure 2-17

Step 5 Use the reversing steps to remove the blade holder.

Step 6 Eject the blade. Push “Blade eject pin” to eject blade when the blade needs to be
replaced.

Caution

The blade will lose its sharpness after a period of usage, the cutting quality might be affected.
By increasing the cutting force, it might do the trick. However, once the blade is worn out

and no longer provides a reliable cutting, you should replace a new one. The blade is
consumable and must be replaced as often as necessary to maintain the cutting quality. The
quality of the blade deeply affects cutting quality. So be sure to use a high quality blade to
ensure good cutting results.

2.5 Cable Connection

The cutting plotter communicates with a computer through a USB (Universal Serial Bus), Parallel

port (Centronics), or a Serial port (RS-232C). This chapter shows you how to connect the cutting
plotter to a host computer and how to set up the computer/cutting plotter interconnection.

Il Notice: When USB connection is enabled, both parallel port and serial port will be disabled
automatically.

Installation 2-9
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Parallel port ]
Serial port

USB port

Figure 2-18

25.1 USB Interface
Jaguar IV build-in USB interface are based on the Universal Serial Bus Specifications
Revision 1.1. (Operation system of Windows 95, Windows NT don’t support USB ).

m  USB driver installation

v' If you are using Windows 2000 / XP / Vista/ 7 as your operating
system, make sure you log in using the “Administrator”
account.

Use the USB One-click Installation for quick driver installation. Follow the simple steps
below for driver setup.

Step 1:

Connecting your GCC cutter

1. Turn on the machine.

2. Connect the USB connector to the machine and then USB driver will installed
automatically. It will take a few minutes to find the device. Please DO NOT disconnect
the USB cable until the installation has completed.

3. You can double click the USB icon on the taskbar to make sure the USB device is
detected.

TR0 EIBLL 151
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Your device is ready to use

USE Prnting Suppeort o Ready to use
Me Printer Attached o Ready to use

Step 2: Installing the software
(1) Put the installation CD into your CD-ROM. Please make sure that the USB device is
connected before you start the driver installation.

(2) Choose the model you want to install from the driver list and click on either the 32 bit
or 64 bit driver installation depending on the operating system installed on your
computer to start the installation. (The Expert Pro model is used as an illustration in
the following steps.)

—
GCC... '

e BFERT 24
S BTERT Win 7 / Vista { XP ls_z-mr Driver]

Win 7 [ Vista { XP [64-bit Driver] |
User Manual

#ugHn Jaftware
[~ szt GJt | Design Source -Cl.narl |

& Install Acrobot 6.0 =
S exm 4'
o ExrERT 0

(3) Click “Next” to start the driver installation.

Fl GCC Driver Installation

X
Start Installation a
=

You are now ready to install GCC Driver,
Please make sure that USB device is connected.

Press "Next" to continue or press "Cancel" to exit the installation.

[ Hest s I Cancel

Installation 2-11
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GLCC Driver Installation

2~ =

C: M DO S spstem32hspooltdrivers'aw32=BENG CC_register. exe

Current File

Copying File:

ANEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE
Al Files

Time Remaining 0 minutes 0 seconds

Wise Installation “AizardR

(4) The installation will take a few minutes to complete and you will see a message below
and click on “OK” upon completion. Enjoy your GCC cutter!

GCC Driver Installation

Add Expert Pro-60 Printer driver Successiully

Note:
(1) If the driver is being installed for a second time, the user will be prompted as to whether a
second copy of the driver installation is required.

GCC Driver Installation

The Expert Pro-80 driver installed
. Do you want add attachment

Yes e}

(2) If the user selects yes, a second copy of the driver will be installed.

GCC Driver Installation

'i ) Add Expert Pro-60_1 Printer driver Successfully

2.5.2 Parallel Interface

Installation 2-12
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e Connecting to the Parallel (Centronics) Port

1. Connect a parallel cable to the cutting plotter and the host computer

2. Set up the output port LPT1 or LPT2 from your software package

3. Send the data to your cutting plotter directly. Or, use DOS commands like TYPE or PRINT
to output data.

ICaution!! Please turn off the plotter before plugging the print cable|

2.5.3 RS-232 Interface

e Connecting to the RS-232 (Serial) Port

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial
connector of the assigned serial port (COM1 or COM2) of your host computer.

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the
setting of software package, refer to chapter 3 — “Misc” key description.

ICaution!! Please turn off the plotter before plugging the RS-232C cable|

2.5.4 Data Transmitting

There are two options to transmit the data from the computer to the cutting plotter:

Option 1: With proper interface settings, the data can be transmitted from your application
software package to the cutting plotters directly.

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2 commands.
As long as the file is HP-GL or HP-GL/2 format, the cutting plotter can output the
data precisely.

Installation 2-13
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3. The Control Panel

This chapter describes the button operations with the LCM menu flowcharts of Jaguar IV. When
the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default

parameters.

3.1 The LCD Panel

-

POWER
Q @

SPEED

O O O \/

MISC TOOL SELECT DATA CLEAR CUT TEST LINE PAUSE / RESUME ENTER

ST OTO

FORCE OFFSET @ @

ON/OFF

< LCD Control Panel on Jaguar IV series >

Key Function
LCD Screen To display functions and error messages.
Power LED To indicate the power status ( light up: power on; light off: power off )

4 Arrow Keys

To move position, select function, or change setting.

ENTER To set item or register the immediately preceding input value.
PAUSE/RESUME | To temporarily halt cutting process or to continue

ON/OFF LINE To switch modes, stop cutting job, or abort changes of settings.
OFFSET To adjust the value of blade’s offset.

FORCE To adjust the value of cutting force.

SPEED To adjust the value of cutting speed and quality.

CUT TEST To perform cutting tests in different ways.

DATA CLEAR To clear up buffer memory.

TOOL SELECT

To select tools.

MISC

To set up functions.

Please see details in “3.4 Menu ltems”

The Control Panel
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3.2 Menu in On-line Mode

Power On  Jaguar IV in processing

GCC Cutter
LCM Version- - -

Jaguar IV
Firmware: Copyright:

\ 4

Place Media And Then Lower
Down The Lever

v

Roll Edge Single
A
\ > useA ¥V Do select

v

Sizing Media Width Lever Up
To Abort

Sizing Media Length Lever Up

To Abort

Top menu v
S--- F----- O----
L--mmme W-----T1M

Sending data

» Pause Setup Resume
[PAUSE ]
[ FORCE] .| Force:80 f A use A to select; [ENTER] to enable the setting
> OKENTER  V/ \%
[ SPEED | Speed: 72 cm/s AN
> select<ID> okENTER V
[ OFFSET] Offset: 0.275 mm A UP Soeed.
> . > peed: 72cmls A
OKENTER ~ V Select<] [> OK:ENTER Y/
Clear Data Memory -
[DATACLEAR] | {.cancel OK:ENTER p| Quality: normal A
Select<] [> OK:ENTER \/
[TOOL SELECT] | 1S:72 F:80 0:0.275M A

Select<] [> OK:ENTER Y/

Set Smoothing Cut
Select:<] [> OK:ENTER

\ 4

OverCut: 0.00mm A
Select<] [> OK:ENTER Y/

\ 4

Set Tangential Mode
Select:<] [> OK:ENTER

\ 4

\ 4

Pouncin 0mm A
Select<?[> OK:ENTER Y/

The Control Panel 3-2
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3.3

Menu in Off-line Mode

Press [ON/OFF LINE] to switch to the offline mode

Offline For System Setup

[ FORCE] o Force:80 of . /\ | 5~600 with an increment of 5(gram force)
P OK:ENTER
AV
[ OFFSET] _ JAN
» Offset: 0.275 mm _ . .
OK-ENTER / |0.000~1.000 with an increment of 0.025(mm)
[DATACLEAR ] »| Clear Data Memory
N:Cancel OK:ENTER
KDA V] o IPAV move origin
[ SPEED .
» Speed: 72 cm/s . ; ;
Select: OK-ENTER Speed:3~153 with an increment of 3(cm/s)
<>
UP Speed: 72 cm/s A . .
Select<] [> OKENTER Y/ | UP Speed:3~153 with an increment of 3(cm/s)
Quality: normal A | Draft, Fair, Normal, Fine, Small Letter
Select<] [> OK:ENTER Y/ e ' '
CUT TEST]
P Square Cut
Select<] [>  OK:ENTER
» Repeat Last Plot
Select<] [>  OK:ENTER
Pattern: Arrow —— Pattern: Cross, Arrow
P Pattern Setting »| Change: OK: ENTER
Select<] [>  OK:ENTER
Ratio: 100% |——» Ratio: 100%, 200%, 300%, 400%
P Ratio Setting » Change: OK: ENTER
Select<] [>  OK:ENTER »| Test Blade Holder
OK: ENTER
P Blade Length Adjust Set Length 0.00mm
Select<] > OK:ENTER »{ Change: OK: ENTER Test Blade Length
» OK: ENTER
Turn CW, Turn CCW
The Control Panel 3-3
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Offline For System Setup

[TOOL SELECT]

1S:72

\ 4

F:80 0:0275M A
Select<] [> OK:ENTER Y/

Set Smoothing Cut
Select: <|> OK:ENTER

OverCut:

\ 4

Select<] [> OK:ENTER

0.00mm
OverCut:0.00-1.00mm with an

<>

increment of 0.05mm

\ 4

Set Tangential Mode
Select:<] [> OK:ENTER

\ 4

Pouncin 0 mm
Select<? [> OK:ENTER

Pouncing:0-200mm with an

<>

increment of 1mm

Panel Setup
Select: <[> OK:ENTER

\ 4

Restore default ?
Select<] [> OK:ENTER

\ 4

Save parameter?
Select:<] [> OK:ENTER

[MISC]

Firmware:
FPGA: Vx.x

X XXX

mm/dd/yy

\ 4

Auto Unrolled Media
Select<] [> OK:ENTER

\ 4

Vacuum
Select<] [> OK:ENTER

\ 4

Media Back & Forth
Select<] [> OK:ENTER

\ 4

Set Communication
Select<] [> OK:ENTER

\ 4

AAS Offset
Select<] [> OK:ENTER

\ 4

Paper Saving Mode
Select<{] [> OK:ENTER

Both Expanded Mode. Length Expanded Mode.
Width Expanded Mode. Both Unexpanded Mode

\ 4

Select Language
Select<] [> OK:ENTER

English, Chinese

\ 4

Select Unit
Select<] [> OK:ENTER

Metric (cm/gf) or English
measurement (inch/oz)

\ 4

Scale Length

Select<] OK:ENTER

\ 4

Scale Width
Select<] [> OK:ENTER

\ 4

USB Printer Type
Select: <] [> OK:ENTER

GCC USB Mode
Common USB Mode

The Control Panel
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3.4 Menu Items
Below describes the functions of menu items
Menu or Key Function Setting Default
--- Media sizing ---
Roll To measure media width. Maximum Tracking
150 meters
Edge To measure media width and pull the media back till the front |Maximum Tracking
paper sensor open. 150 meters
Single To measure media width and length. Maximum Tracking
10 meters
--- POWER ---
To indicate the power status.
[ Arrow Keys ]
1. To move the tool carriage position on X or Y axis.
2. To select functions or change values of settings.
[ ENTER ]
1. The displayed parameters will be saved automatically.
2. To set a new origin at the present tool carriage position.
In “offline” mode, moving the tool carriage to desired
position by [Arrow Keys], then press [ENTER] key to set a
new origin. While moving with the parameters of XY-axes
displayed, press [MISC] key will enable fine-tune
movement; press [MISC] key again to disable the function.
[ PAUSE/RESUME ]
To temporarily halt the cutting process.
To resume the process by press [Pause/Resume] key again.
[ ONLINE/OFFLINE ]
1. To switch between online mode and offline mode.
2. To stop the cutting job or abort the change of setting.
Once press this key, the cutting job will be terminated
immediately and cannot be resumed.
[ OFFSET ]
To set or modify the distance between the blade tip and the |0.000~1.000mm |0.275mm
center axis.
[ FORCE ]
To set or modify the value of tool force. 5~600gram; 80 gram
5 gram/per step
[ SPEED ]
Speed To set or modify tool speed at horizontal moving. 3~153cm/sec; 72cm/sec
3cm/sec per step
Up Speed To set or modify tool speed at vertical moving. 3~153cm/sec; 72cm/sec
3cm/sec per step
Cutting Quality | To set or modify cutting quality. Dratft, Fair, Normal
While cutting small letter, set as “Small letter”. Normal, Fine,
While cutting in high speed, set as “Draft”. Small Letter
For normal operation, set as “Normal”.
[ CUT TEST ]
Square Cut To perform a cutting test at present blade position.
For more information, please refer to “4.3 Adjusting the
Cutting Force and Offset” to adjust blade force and cutting
speed.

The Control Panel
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Note: while the Offset value setting at 0.000 mm, “Set
Tangential Mode” will automatically be disabled.

Repeat Last Recut: 1~99;
Plot To repeat the last job without re-sending the data. 1 per step
Copy: 1~99;
To copy the last job without re-sending the data. 1 per step
* 1mm gap will be auto-generated between 2 copies).
* |f the media length is not enough to continue, it will show
below message on LCM:
Out Of Space; #
of Copies finished
* If both functions are enabled at the same time, the cutter will
perform the last setting only.

Pattern Setting |To provide two patterns for cut test “Arrow” and “Arrow”
Note: It is recommended to select “Cross” if you are working |“Cross” patterns th
on thick pieces of materials. Note: the

default
pattern for
Jaguar
IV_Ris
“Cross”
Ratio Setting |To adjust the size of the pattern 100%, 200%, 100%
300%, 400%
Blade Length |To adjust the length of the blade 0.00mm-5.00mm [0.00mm
Adjust Note:
1. Keep your blade length as 0 before you start adjusting.
2. Testthe blade holder first and then test the blade length by
pressing ENTER.
3. Keep the blade holder at the same position when you
perform blade holder and blade length tests.
4. When blade holder and blade length tests are finished, the
screen will show you to what degree (the unit of the value
following “CW” or “CCW" is “circle”) and in which direction
[CW (clockwise) or CCW (counterclockwise)] you should
turn the adjustment knob.
EG, Turn CW 0.5 is telling you that you should turn the
knob for half a circle clockwisely.
5. The value on the screen will be 0.0 when the blade length
is perfect and no more adjustment needs to be made. You
may start cutting at this point.
[ DATA CLEAR]
| To clear up buffer memory. |
[ TOOL SELECT ]

Set Smoothing | To enable smooth-cutting function. Enable

Cut

Over Cut To generate an overcut to facilitate weeding. 0.00mm-1.00mm [0.00mm

0.05mm/per step

Set Tangential | To enable the emulated tangential-cutting mode for thicker Enable

Mode media types and small letter cuts.

The Control Panel

3-6




GCC.. Jaguar IV User Manual

Pouncing To make perforated patterns. 0~200mm Omm

* In order to use this function, Pouncing tool must be installed.

* Before start pouncing, place pouncing strip on top of the
cutting pad to protect the cutting pad.

* Set the value as 0 mm to disable the pouncing mode.

* Pouncing tool is an optional item.

Panel Setup Accept setup command:

To accept commands of the Force, Speed, Cutting Quality,

and Offset only via software.

Control panel only:
To accept commands of the Force, Speed, Cutting Quality,
and Offset only via control panel of the cutter.

Restore To turn all parameters of the menu items to factory-default
Default settings.
Save To save pattern(s) of cutting parameters for later use. Patterns1~4 Pattern 1
Parameter

[ MISC ]
Auto Unrolled | To avoid paper jam and motor crash by automatically unroll Enable
Media media (50cm and up) before cutting while enabled.

* Auto-unroll only effects on roll/edge media.
* Using Single mode to size media will disable this function
automatically.
* If the length of the rolled media is less than 2 meters or the
weight is light, it is recommended to set this mode disabled.

Vacuum To help improve tracking and cutting accuracy by turning on Enable
the fans. If you turn off the vacuum system, the fans
will remain inactive during cutting or plotting.

AAS Offset To set or modify AAS offset value.

You can refer to “5.3 Printer Test” for more details.
Media Back To enable to save time on repeated cutting jobs and better Disable
& Forth tracking.

After cutting job has finished, the media will move back to the
origin, then move to the end of the plot.

Paper Saving | To save media by four different modes: Both

Mode 1. Length expanded mode 2. Width expanded mode unexpanded
3. Both expanded mode 4. Both unexpanded mode mode

Set To build up the communication between host computer and

Communication | cutter.

Baud Rate is to determine the speed of data transmission.
Data Bits refers to the size of one block of data.

Parity is used to check if data was revived correctly or not.
9600, n,7,1,p 9600pbs, 7 Bits with NO Parity

9600,0,7,1,p 9600pbs, 7 Bits with ODD Parity
9600,e,7,1,p 9600pbs, 7 Bits with EVEN Parity
9600, n,8,1,p 9600pbs, 8 Bits with NO Parity
9600, 0,8,1,p 9600pbs, 8 Bits with ODD Parity
9600, e, 8,1, p 9600pbs, 8 Bits with EVEN Parity
19200, n,7,1,p 19200pbs, 7 Bits with NO Parity
19200,0,7,1,p 19200pbs, 7 Bits with ODD Parity
19200,e,7,1,p 19200pbs, 7 Bits with EVEN Parity
19200, n,8,1,p 19200pbs, 8 Bits with NO Parity
19200,0,8,1,p 19200pbs, 8 Bits with ODD Parity
19200,e,8,1,p 19200pbs, 8 Bits with EVEN Parity
Firmware To display the version number of Firmware and FPGA code.

Version
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Select To select displayed languages on LCM panel in English, English
Language Spanish, Italian, Deutsch, Japanese, Portuguese, Polish,
Turkish or French.
Select Units Provide two-unit systems for users convenient. cm/gram; Metric
inch/oz

Scale Length To adjust the scale of media length and width that may cause
by the thickness of the media.

The Denominator is the actual length, and the Numerator is
the ideal length measured from the resultant.

For example, cutting a line with 500.0 mm length. The

Scale Width procedure as follows:

1. Press the [LEFT ARROW] to choose the Numerator and
select 500.0 mm,

2. Cut the length by sending a graph file,

3. Measure the length then use the [RIGHT ARROW] key to
choose the Denominator, then

4. Press [UP ARROW /DOWN ARROW] to change the values
of the actual length.

USB Printer To select USB Mode from the LCM panel. Two USB modes Common

Type are available: GCC USB Mode and Common USB Mode. USB Mode

GCC USB Mode: For 32 bit driver
[Windows XP/2000/ 7 /Vista]

Common USB Mode: Both for 32 bit & 64 bit driver
[Windows XP/7/Vista]
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4. Operation

4.1 Media Loading

4.1.1 Loading the Sheet Media
To load the media properly, please follow the procedures listed below:

Step 1

Use the lever on the upper right side of the cutting plotter to raise or lower down pinch rollers.
Pull the lever forward until it makes a clicking sound then the pinch rollers are raised (Figure
4-1).

Lever P

Figure 4-1

Step 2

Load your media on the platen and slide it under the pinch rollers from either the front side or
the backside. The alignment rulers on the platen extension will help you to adjust the media
precisely.

Note:

Be sure that the media must
cover the paper sensors on the
platen when loading the media.
At least one of the two paper

sensors (Figure 4-2) should be
covered. Once the media covers
the sensor, the cutting plotter will
size the media width and length
automatically.

Paper sensors N

Figure 4-2
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Step 3

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be
positioned above the grid drum. The white marks on the top trail will remind you where the grid
drums are (Figure 4-3). White marks

Figure 4-3

Step 4
Push the lever backward to lower down the pinch rollers.

Step 5
Turn on the power, the tool carriage will measure the size of the media automatically. And the
plotting cutter begins to work.

Note:

1. Always adjust the position with the pinch roller raised.

2. Move the pinch roller by applying force at the rear portion of the pinch roller support.
3. Do not move it by holding its front rubber roller (Figure 4-4).

Incorrect

Figure 4-4

Operation 4-2



GCC.. Jaguar IV User Manual

4.1.2 Loading the Roll Media
Step 1
Put the roll media guide bushes on two roll holders (Figure 4-5).

Roll media guide bushes

Figure 4-5

Step 2
-- Option A (Recommended)
Insert the two roll holders into the roll media support set then place the roll media directly
between the two roll holders (Figure 4-6).

Figure 4-6

-- Option B (Use the media flanges)
Insert a roll media flange at the end of each roll

media and tighten the thumbscrew until the roll Figure 4-7

media is firmly gripped(see Figure 4-7).

Then put the roll media on the roll holders. Adjust the
position of the roll media ensure that media flanges are
able to run in the grooves of media guide bushes. Figure 4-8
(Figure 4-8)
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Step 3

Load the media on the platen. Please refer to “4.1.1 Loading the sheet media”. After loading
the roll media, flatten the media on the platen and hold the front edge of the roll media firmly
(Figure 4-9).

Figure 4-9

Figure 4-10

Step 4
Turn the roll downward to make an equal tension
across the media (Figure 4-10)

Note :
Make sure that the media
tension is equally distributed

from left to right. If the media
Step 5

Move the pinch rollers to the appraise location and
note that the pinch rollers must be positioned above
the grid drums.

were not tightened enough
against the platen, it would
cause tracking problems!

Step 6
Push the lever backward to lower down the pinch rollers.

Step 7
Fix roll media guide bushes on the roll holder to secure the roll media.

Step 8
Turn on the power switch, the tool carriage will sizing the media automatically.
Then the cutting plotter is ready to work.

Step 9
Use the reverse steps to remove the media.

Operation 4-4
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4.2 Tracking Performance

In order to achieve the best tracking performance for a long plot, we recommend some
significant media loading procedures described as follows:

If the media length is less than 4 meters, leave the margin of 0.5mm—25mm in the left and right

edges of the media (Figure 4-11).

0.5mm - 25mm

Pinch roller HT H

. —» Pinch roller

0.5mm - 25mm

Figure 4-11

If the media length is greater than 4 meters, leave at least 25mm margin on the left and right
edges of the media (Figure 4-12).

T
]
1
]
i
—»
1

> or =25mm H’ H > or =25mm
‘_

—>
Figure 4-12

I

Please refer to the paragraph “4.5 How to Make A Long Plot” for more detalils.
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4.3  Cutting Force and Offset Adjustment

Before sending your designs for cutting, you may perform a “cut test” to generate satisfactory
cutting results. The “Cut Test” should be repeated until the appropriate cutting conditions for the
media are discovered.

After sizing the media, press [CUT TEST] button to select the “square cut”, and press [ENTER
KEY] to confirm.

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively.
Press [ARROW KEY] to move the tool carriage to the position where you like. Then, press the
[ENTER KEY] to perform Cut Test.

Note: At the same time, the new origin is also set at the cutting test position.

When the cutting test is completed, a pattern appears. Peel off the pattern to see if it can be
easily separated from the media base. If yes, the setup tool force is appropriate. If not or cut
through the back paper, press [FORCE KEY] to adjust the tool force until an optimum force is
obtained (Figure 4-13).

t

Sqguare Cu
Select <> OK:Enter

i Press ENTER_KEY If the pattern appears to be BB or CC layout,
]%VQD Mowve cwt test M\ press [OFFSET KEY] to adjust the offset
i Press ENTER_KEY value until AA pattern discovered.
AA BB CC
PN
< ﬁ > @ > @ﬁD Press SPEED_KEY,
FORCE_KEY,
~_ OFFSET_KEY to setup
Comntimnous Square Cu t or
N: ON/OFFLINE OK:Enter Pl‘essar\‘gwkeyslo
i Press ENTER_KEY desn‘edilouill?eozuttor next
Finish sq RTER KT
-PRART
3mm 3mm

[ [ _ Wachine _ |

80
80

f sl H Figure 4-13
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4.4 How to Cut 3mm Letters

To obtain good quality output, narrow media is recommended. However, if wide media is used,
you should:

1. Position two pinch rollers as close as possible to both edges of the cutting area.
2. Make sure the loaded media is held flat with equal tension across the platen.
3. Suggested operation settings:

Tool force: 55 gf. (or depending on the material)

Cutting speed: 45-50 cm/sec

Tool up speed: 45-60 cm/sec

Smooth cut: Disable

Quality: Small Letter

4.5 How to Make A Long Plot

When you are making a long plot with a roll of heavy and wide vinyl, paper you need to use the
“AUTO UNROLL MEDIA" function. The following parameter settings are to help users get the
best cutting quality. The actual output quality may vary when using different kind of materials

1. If the length of graphic is between 3m and 5m, the cutting speed is
better slower than 72cm/sec and the cutting quality is set as Normal.

2. If the length is longer than 5m or if the material type is difficult to cut, it
is better to further slow down the cutting speed.

3. After loading the roll media all pinch rollers are raised at this stage,
flatten the media on the platen and hold the front edge of the roll media
firmly (Figure 4-14).

Figure 4-14
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Then turn the roll downward to make an equal tension across the media
(See Figure 4-15)

Make sure that the media
tension is equally distributed
from left to right. If the media
Is not tight enough against the
platen, it will cause tracking
problems.

Figure 4-15

4. Engage pinch rollers.

5. Fixes roll media guide bushes on the roll holder to secure the roll media.

6. The protrusion length of the blade should be longer than the thickness of the vinyl.
(Please check the “Blade Specification: About the Tool” in Appendix.) After you
notice all the above, you'll enjoy your gigantic signs production!

4.6 When Completing the Cutting Job

After completing the cutting job, raise the sheet-loading lever, and then remove the material.
You can also cut off the finished job by the Safe Blade (a standard accessory) along the knife
guide. (Figure 4-16)

Figure 4-16
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4.7 Jaguar IV Print Driver setting
4.7.1 Jaguar IV Print Driver setting>Option Page

Die Cut

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of
cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through
the backing of the material while Kiss Cut cuts through only the top layer but not the backing.
This will leave only tiny bits of the backing attached to the top layer, creating complete individual
patterns with backing sheets (see figure 1 and 2).

Blade

Top layer

Vinyl

Backing sheet

9 @

Kiss cut Die cut

Figure 1 Cutting line

Die Cut

Kiss Cut

Figure 2
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To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish
for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 2).

Option | Paper

Attrib File Function
Pen Speed 18 com/is

< ¥

Save

Load

Offzet 0250 mm Save To Default

£ ’

Delete

[
[
[ Original
[
[

Histary Files : “Note:
Qualty | Drat 4 The length setting for the
[ Use Plotter Setting cutting line of Die Cut is in the
[ Back to Home / range of 0-2000mm whereas

[ &&5: Origin wsing printer setting

TeTr that of Kiss Cut is 0-100mm.

Diie Cut Kiss Cut
Length 1.00 T Length 1.00 T

40

Foree | B0 a Farce

Figure 3

When the job is completed and you untick the Die Cut function, you will be able to adjust the
pen speed, pen force, and offset in the section on the top following normal operating
procedures (see figure 3).

Option | Paper |
Attrib Ale Function
Pen Speed 18 com/s [ gz ] Note:
3 > [ — | 1. The extension of the blade has
F::” Eale g _ Driginal ] to be set to cut through both the
Offset T [ Save Ta Defaul | top layer and the backing in the
¢ : & || | Delete ] very beginning. You then adjust
_ . History Files : the tool force for the best cutting
Quality | Draft v ; )
performance.
Fllse ousnen 2. Once the Die Cut function is
[ Back to Home . . .
B e activated, it will perform on all the
[ Die Cut line segments on the object.
Figure 4

Operation 4-10



GCC.. Jaguar IV User Manual

4.7.2 Jaguar IV Print Driver setting>Paper Page

Connecting Multiple Cutters to one PC

This function allows your computer to recognize the cutter you wish to perform your job on from
other cutters with the same model name and printers connected at the same time, eliminating
its confusion when you send your image to the cutter.

To activate this function, go to “Paper” and tick “Connecting Multiple Cutters to one PC” (see
figure 1). Please do not tick this box if only one cutting plotter is in use.

@' Expert 24 Properties

| General | Sharing | Parts || Advanced || Security || Dptiu:nn| Faper |

-~ Paper Size =Lt

2 |12DD'EID LY @ Metric [rrim)
N5 |EDD_|:|E| Es  Imnperial [inch)

~Werzion Mo,

Expert 24
Copyright (] Great Cormputer Co.
Al Rights Rezerved.

L 315

GCC..

L gociword. com I

’_ 0k ][ Cancel ][ Apply J

Figure 1

When you are prompted to this window below, change your port setting manually.

Warning

Please noke that wou must change port setking manually under the <FAX and PRIMTER > option.

Yes Mo

Figure 2
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To do this, please go to “Printers and Faxes”, right click on the model you would like to work on
and click on “Properties”.

Go to “Ports” and tick the corresponding USB port (see figure 4). When this is completed, apply
the same steps to other cutters you would like to work on (see figure 5). Please make sure you
connect each cutter back to the same corresponding USB port every time.

| General | Sharing| Parts |Advanced | Security | Dption-li -F'aper |

AT

djhg Expert 24

Frint to the following port(z). Documents will print ta the first free

checked part.
Part Description Printer ~
O useood Wirtual printer port fo...  HP Color Las
O useooz “Wirtual prinker port fo...
USE00 Wirtwal printer port fo...  Jaguarly-18:—

O Send To Miciosoft One.. Local Port

O Micrasoft Document Im... Local Port

O %PsPort: Local Part |
< - | >

[ Add Port... ] [ Delete Port ] [ Configure Port...

Enable bidirectional suppart

[ Enable prirter pooling

| General | Sharing| Parts |T&dvanced | Security | Dption_ii Paper |

%
@ Expert 24

Frint to the following portfs). Documents will print to the first free
checked port,

Fort Drescription Frirter =
O useoo4 “irtual printer port fo...  HP Color Las
U5B002 Wirtual printer part fo...

O useom irtual printer port fo..  Jaguarly-18 —

O Send To Miciosaft One...  Local Port

O Microsoft Document Im...— Local Port

I XPSPort: Local Port o
< I | 3

[ Add Port... ] [ Delete Port ] [ Configure Port... ]

al support

Enal

[[] Enable printer pocling

Figure 5
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Chapter 5 Accu-Aligning System

51 Introduction

The Jaguar |V series cutting plotters feature a standard Accu-Aligning System (AAS I1l) to
guarantee precise contour cutting quality by detecting the registration marks printed around the
graphic.

Notice
B Avoid any kind of light source horizontally illuminating the AAS module.

- PROHIBITED - ACCEPTABLE

B DO NOT take off the cover of AAS module while in operation.

- PROHIBITED
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5.2  AAS Calibrating the System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS
operation. To operate the AAS you need to learn about the method of media feeding firstly.
(Refer to 4.1 Media Loading.)

5.2.1 Media Calibration

Media Calibration is to ensure the sensor being able to recognize the registration marks.

The factory default works on a wide range of materials. However, certain types of

materials may not work properly. Performing a media calibration may become necessary
while working with such materials to change the sensitivity of AAS for greater reliability.
Media calibration adjusts the media feeding according to media type for better accuracy

during cutting.

B When to use

We suggest white media for best cutting result. It is not necessary to perform media

calibration every time unless the registration marks on the printed media become
undetectable in AAS sensing process.

5.2.2 AAS Calibration

The first registration mark is designed to be different in order to identify the origin for AAS
auto-detection. The following precaution must be aware for registration marks to be read

automatically.

Type of media

Registration mark pattern

Reading range required for detection the registration marks
Position for registration marks and medium

The registration marks have to be:

Created by cutting software like SignPal or GCC CorelDRAW plug-in
In black color

“L” Mark Length: 10mm~50mm, suggested 25 mm

“L” Mark Thickness: 1Tmm~2mm, suggested 1 mm

Margin: 1mm~50mm, suggested 5 mm

The cutter can not detect the marks while:

Cutter carriage is not located near the outside area of first mark before
detecting (See the picture in page 5-7 for auto-detecting area of first mark.)
Medium thickness is more than 0.8mm

Transparent medium is used

Accu-Aligning System 5-2



GCC... Jaquar IV User Manual

B Non-monochrome drawing. The marks can’t be read if is printed on colored
medium
B Dirty or creased medium surface

5.2.3 AAS Il on Jaguar IV

There are three types of AAS Il mark patterns: 4-Point Positioning, Segmental Positioning, and
Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks
have to be created on your graphic designs by cutting software like SignPal, EasySign or GCC
CorelDraw plug-in. Hand-made marks or drawings won'’t be reorganized by GCC cutting
plotters. For more details about registration mark setting in cutting software, please refer to

‘Appendix A-3 : CorelDraw Plug-In Instruction”, ‘Appendix A-4 : SignPal 8.5 Instruction’,
‘Appendix A-5 : EasySIGN Instruction’ and ‘Appendix A-6 : GreatCut Instruction.

1. 4-Point Positioning
This is the basic mark pattern that AAS Il will auto detect four registration marks and contour
cut images inside those marks.
m  Command: Esc.D1;(XDist);(YDist):
m Layout: 4 L-shaped marks at the 4 corners around the design

]
L

2. Segmental Positioning
In addition to 4 original points, the intermediate registration marks are added on both X axis
and Y axis to help contour cut accurately, especially for cutting large images.
n Command: Esc.D2;(XDist);(YDist);(XStep);(YStep):
[ Layout:
In-between distance on X: 200~600mm, default 300mm
In-between distance on Y: 200-600mm, default 300mm
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3. Multiple Copies
The function is used to duplicate images to let you cut quantities of images at a time.The
AAS |l sensor will automatically scan registration marks for each individual image to ensure
the contour cutting precision.
n Command: Esc.D3;(XCopies);(YCopies);(Space):
[ Layout:
Condition 1 (Default) Condition 2

I

[ Lol

5.3 Printer Test

Before performing AAS contour cutting, it's recommended to print out a test file that you
can find in the enclosed Installation CD to make sure the AAS Il cutting accuracy of
Jaguar V.

There are two testing files for AASII:

1. AAS II_X Y Offset_Caberation_A4 .eps (A4 size)

2. AASII_X Y Offset Caberation 600 600 .eps (Default setting, it is recommended
for testing)

B Print out the testing graphic. ( Please use high precision printer)
B Load the graphic to Jaguar IV and sent the file to test the cutting job
B If there is any adjustments had to be made, you can change the offset value by
following the steps:
* Measure the offset values from the printed line and the actual cutting line.
* Enter the AAS Offset under MISC function for the values you just measured,
then press Enter
* Test the cutting again
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* AAS Il offset X and Y value is defined as following:
Horizontal line is defined as X and vertical is defined as Y

* When the actual cutting line and the printed line need to be changed
towards the direction of origin mark, then simply add the negative value of
the offset. If the direction is from the opposite of the origin mark, then enter
positive values for the offset. This method apply on both X and Y axle.

For example:

If the values set in cutter is X: 0.50 mm Y 0.50 mm and the measurement is
X1:-0.25 mm Y 1:#0.25 mm. (In following figure, the Blue Line refers to the Y Value,
and the Red Line refers toe the X value.)

We need to adjust AASII offset X new : (X + X1) Y new : (Y + Y1) which means X
new : 0.25 mm Y new : 0.75, then save the set new value to cutter.

|
|

X (+ Value) : X (- Value)

Y (- Value) : Y (- Value)
|
|
|

X (+Value) | X (- Value)
|

Y (+ Value) : Y (+ Value)
|
|

Origin
Note:

B Before adjusting the AAS Il settings, please proceed scaling for width and length.

B The blade offset value isn’t set for this test graphic, please set it according to the
blade you use.

B If you have any question, please contact us or your local distributor for assistance.
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54 Contour Cutting
For accurate contour cutting with AAS function, please proceed the following steps:

Step 1 Creating Graphics
m Create the graphic that you want to print and cut in your software.

& BABY
% IN CAR

m Create a contour for cutting around the graphic.

&, BABY

o> IN CAR

TIPS1: Leave some space between the graphic and contour line.
TIPS2: Create the contour in a separate layer and assign a different color for it.

m Add registration marks around the graphic.
Note:

The Multiple Copies function is also available. It automatically copy the graphic and
registration marks.
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Step 2 Placing the Registration Marks
m The AAS Layout Instruction:

10 mm{0.3% in)
30 mm(1.18n) 10 mm(0.39 in) Track of Pinch Roler jgey iip
10 mm{0.3% in)
5 mm{0.2 in)
Gmml 2nd mark AAS Il Layout Instruction 3rd Mark

Standard media verification:

| Oracla white-color vinyl [451)
25 mm Smm{0.2 in) / Grafityp white-color vinyl
[0.98 in) {5V white-color vinyl
20mm .
[0.79in) Mark size
: / Length: 25 mm|(0.98 in) :
/ Thickness: 1 mm{0.04 in) = BO mm[3.15in)

margin between mark & graph: 5 mm{0.2 in) “wh 4 .\.,,"
Both unespanded mode]
X Distance (petween 2nd & 3rd monk):
/ Maximum: 600 mm|(23.62 in) 50 mm(1.97 in)
Fomtha oda/

{ Minimum: 70 mm {276 in) (depends on grophic design|

Y Distance (betwean 15! & Ind morks):
[ Maximum: 1770 mm([49.69 in] |depends on media & cutten
/ Minimum: 70 mm|(2.76 in] (depends on graphic dasign)

|ungsr Poper Soving Mode/
Both sspandad mode)

Repeatability: less than 0.3 mm|0.01 in)

WORKABLE AREA

(light grey blocks)

dth Mark
15t Mark

Origin

Auto-detecting area Track of Pinch Raller (grey stin 30mm|1.18in)
Irey Wiangkd]

* Auto-detection function on the 1% mark covers the grey area
m  Suggested 30mm margin on both left and right sides of media sheet.
m  Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on
the bottom edge to prevent sheets dropping or any error occurred while media sizing.

Step 3 Print the Graphics
m Print the graphic and the marks with your printer

(Scaling = 100%). -
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m When printing on a roll media, make sure the orientation as following:

Step 4 Load the printout onto cutter
m The Origin Mark is is different from the rest registration marks. Please make sure the

media is fed with correct direction.

Step 5 Cut the Contour
m Send out the command from software to perform the contour cutting job.

5.5 Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.

Keep light sources simple and avoid illuminating from the sides of cutter.
Before operating AAS, change the maximum paper size in Jaguar IV driver
property.

STEP 1 Find the Puma Ill model in the “Printer & Fax” folder of your PC.
STEP 2 Open the Properties window and select the “Paper” tab.

STEP 3 Change the maximum Paper Size of X to 1200mm.

Adjust the cutting speed to between 300~600mm/sec.

Avoid the registration marks locating on the tracks of pinch rollers.

Accu-Aligning System 5-8
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6. Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the
cutting plotter. Except for the procedures mentioned below, all other maintenance must be
performed by a qualified service technician.

6.1 Cleaning the Cutting Plotter
Cleaning the machine properly and regularly will ensure optimal performance out of your
machine.

Cleaning Precaution !
e Unplug the cutting plotter before cleaning it

in order to prevent electrical shock.

e Never use solvents, abrasive cleaners or

| strong detergents for cleaning. They may
damage the surface of the cutting plotter
and the moving parts.

Recommended Methods:
e Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, with a damp cloth
immersed in water or alcohol. Dry and wipe any remaining residue off a soft, lint-free cloth.

e Wipe all dust and dirt from the tool carriage rails.

e Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the pinch
roller housing.

e Clean the platen, paper sensors and pinch rollers with a damp cloth immersed in water or
alcohol, and dry with a soft, lint-free cloth.

e Wipe dust and dirt from the stand.

Basic Maintenance 6-1
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6.2 Cleaning the Grid Drum

1. Turn off the cutting plotter, and move the tool carriage away from the area needed to be
cleaned.

2. Raise the pinch rollers and move them away from the grid drum for cleaning.

3. Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface.
Rotate the drum manually while cleaning. Refer to Figure 6-1.

...............

/

Figure 6-1

6.3 Cleaning the Pinch Rollers

1. If the pinch rollers require a thorough cleaning, use a lint-free cloth or cotton swab to wipe
away the accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch
rollers from rotating while cleaning, use your finger to hold the pinch rollers to prevent them

from rotation

2. To remove the deeply-embedded or persistent dust, use the lint-free cloth or cotton swab
moistened with rubbing alcohol.

Note: The daily maintenance of your cutting plotter is very important.
Be sure to clean up the grid drum and pinch rollers regularly for better
cutting accuracy and output quality.
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1. Trouble Shooting

This chapter is to help you correct some common problems you may come across. Prior to
getting into the details of this chapter, please be sure that your application environment is
compatible with the cutting plotter.

Note:
Before having your cutting plotter serviced, please
make certain that the malfunction is in your cutting

plotter, not the result of an interface problem or a
malfunction in your computer or a software problem.

®- Why is the cutting plotter not functioning?

Possible Causes:
7.1 Non-Operational Problems
Check the following first:
B Does the AC power cord plug in properly?
B Does the AC power cord connected to the power connector properly?
B Does the power LED still illuminate?
Solutions:
If the LCM is able to display the message, the cutting plotter should be in a normal
condition. Switch off the cutting plotter and turn it on again to see if the problem still

existing.

If the LCM is not able to display any message, contact the technician from your dealer.

Trouble Shooting 7-1
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7.2 Operational Problems

Some mechanical problems or failure during operation will cause some problems. The error
messages shown on the LCM present the problem first, and followed by recommended actions.
If the problem still exists after the recommended actions have been done, have your cutting
plotter serviced.

This message indicates that there might be a
problem on the X axis. Check if the drum is
working well and if the media is well loaded.
Correct the problem and re-power on to
reboot system.

Error, Check Media
Or Drum or X Motor

This message indicates that there might be
an obstruction to carriage relating to a
problem on the Y axis. Correct the problem
and re-power on to reboot system.

Error, Check Media
Or Y Motor

This message indicates that the blade
up/down sensor malfunction. Re-power on to
re-boot system. If the problem still exists, find
a serviceman.

Error, Check Carriage
Sensor or VC Motor

This message indicates that the cutting
exceeds the cutting limit. Reload larger media
or re-scale the plot to a smaller size; then
press the key followed by the display of LCM
to continue.

Graph Was Clipped.
Data In Buffer

Trouble Shooting 7-2
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7.3 Cutting Plotter/Computer Communication Problems

The messages showed below present problems in relation to cutting plotter/computer

communication.

Communication Error Is the connection cable
Setup: MISC. key connected to the cutting plotter

and computer properly?

Yes

A 4

[
|
:No
v

Has the interface setting
been done correctly?

Yes

plotter.

Refer to Chapter 2 -
Connecting your cutting

[
|
:No
|
|

A 4

Try the communication
between your cutting plotter
and computer. If it still does
not work, have your cutting
plotter serviced.

Refer to the “MISC” key in
Chapter 3 - Description of
Operation for the port setup.

Note:
The computer also needs to set up compatible communication

parameters to the cutting plotter set up.

If your cutting plotter can not recognize
HP-GL/2 Cmd. Error the HP-GL/2 or HP-GL commands, please
check the HP-GL/2 or HP-GL commands

applied to your cutting plotter are used
properly.

Trouble Shooting
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7.4 Software Problems

Check the following first:

Does your software package indicate that it will work with
your computer and cutting plotter?

Does your software support HP-GL and HP-GL/2 drivers?

(* check the configuration settings of your software.)

I
Yes i No
v v
Does the cutting plotter interface Most well known cutting softwares
match the requirements of your in the world have drivers for our
software? cutting plotters. If not, use
! software that has HP-GL and
Yes | No HP-GL/2 emulation supports and
v v you can chose the following three
Does your Refer to Chapter drivers:
software 2 - Connecting e A3 size: HP7475A
recommend your cutting e Al size: HP7580A
using a different plotter. e A0 size: HP Draf Pro Exl or
cable? HP Draf Master
Yes \\\N\O
v A
Try using the Does the software
recommende vendor provide a
d cable. sample file?
I
|
Yes I No
v v
Re-power on the Do something about the
cutting plotter and error message display on
try to send the file LCM, or consult your
again. software vendor.

Trouble Shooting 7-4



GCC.. Jaguar IV User Manual

7.5 Cutting Quality Problems

Note: The daily maintenance of your cutting plotter is very important.
Be sure to clean up the grid drum and pinch rollers regularly for
better cutting accuracy and output quality.

Is the blade installed correctly and the blade
holder fastened securely?

[
|
:No
|

Yes

v v
Is the blade dull Refer to Chapter 2.4
or chipped? “ Blade Installation”

Yes No

I
|
|
i
4 A 4
Replace Is tool force set up
with a new properly? (The default
blade for tool force is 80 gf)

I

|
Yes | No

v v

Is the tool offset set up Adjust the tool force to obtain an
properly? optimum blade force. Refer to
Chapter 4.3 “Cutting Force and
Offset Adjustment”

Yes No

A 4 A 4
Is there any dirt adhered to Adjust the tool offset to
the blade? obtain an optimum value.

I

|
Yes | No

|

A 4 L 4

Remove the blade Please contact your dealer for technician
and clean it. support.

Trouble Shooting 7-5
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Jaguar IV Specification

Model Number J4-61 J4-101S | J4-132S | J4-183S
Operational Method Roller-Type

Max. Cutting Width 610mm (24in) 1016mm (40in) | 1320mm (52in) | 1830mm(72in)
Max. Cutting Length 50m (164ft)

Max. Media Loading Width 770mm (30.3in) 1270mm(50in) | 1594mm(62.7in) 1900mm(74.8in)
Min. Media Loading Width 50mm (1.97in) 300mm (11.8in)
Number of Pinch Rollers 3 4 6
Acceptable Material Thickness 0.8mm (0.03in)

Drive Motor DC Servo Control

Cutting Force 0~600 g

Max. Cutting Speed 1530 mm/sec (60ips / Diagonal)

Acceleration 4.2 G (gravity)

Offset 0~1.0 mm (with an increase of 0.025mm)

Memory Buffer 4 MB

Interfaces USBL1.1, Parallel and Serial (RS-232C)

Type of Command HP-GL, HP-GL/2

Mechanical Resolution 0.00625mm

Software Resolution 0.025 mm

Repeatability +0.1mm

Curve & Arc Smoothing Yes

Configurable Origin Yes

Test Cut capability Yes

Tangential- emulation Yes

Repeat Yes

Copy Yes

Pouncing Yes

Control Panel LCD (20 digits x 2 lines), 14 Keys, 1 Power LED

Power Supply AC 100-240V, 50~60 Hz (auto switching)

Power Consumption Max. 110watts

Dimension (HXWxD) mm 414 * 930 * 490 1166 * 1430 * 667 1166 * 1754 * 667 750 * 2170 * 1160
(HXWxD) in 16.3*36.6 *19.2 45.9*56.0 * 26.3 45.9*%69.1*26.3 29.5*85.4* 457
Net Weight 37.2 kg 53.3 kg 61 kg 105 kg
Stand Optional Standard

Accu-Aligning System Standard AAS I

Media Basket Optional

Operation Temperature 15°C~30°C / 60°F~86°F

Environment [Humidity 25% ~ 75%

®  Compatible with Windows 2000/XP/7.
® The specification and data sheet may vary with different materials used. In order to obtain the best output quality, please
maintain the machine regularly and properly.

® GCC reserves the right to change the specifications at any time without notice.
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Blade Specification

For cutting thick fluorescent and reflective vinyl. Also for cutting

detailed work in standard vinyl.
20200159G

The blade is 45° with Red Cap(5-unit package), 0.25 mm offset

N ———————

For cutting reflective vinyl, cardboard, sandblast, flock, and
stencil sharp edge.

265012020G

The blade is 60° with Green Cap, 0.50 mm blade offset

S ——————

For cutting thin sandblast mask and stencil with friction feed or
sprocket feed machine.

26500059G
The blade is 60° with Blue Cap, 0.25 mm blade offset

(S ———

For Cutting small text and fine detail. Sharp blade with smallest
offset.

26500060G
The blade is 0.175 mm blade offset with Black Cap

(T ——————— ——
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About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the
LED bombsight (option) used for pointing to the reference point.
OFFSET is the distance that the blade tip is displaced from the centerline of the blade.

«— Blade

<«— Central line

Bladetip —»

i
i
i
—

« |
offset i
Protrusion Length of the Blade
Thickness of
the media (t1)
Protrusion length
of the blade > I
Thickness of the "
base paper (t 2) — v
v

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about
0.3mm ~ 0.5mm beyond the blade holder tip.

Blade Specification A-2
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CorglDRAW Plug-in Instruction

AASII VBA Installer is applicable for CoreIDRAW Version 11, 12, 13, 14, 15

Installation

1. Check the “AAS CorelDraw Installer” folder in Jaguar IV Installation CD, and double click
the “AASIIVBAInstaller.exe” file to run the installation program.

2| _AASI_Reg Mark_Setting 01_03_02 jsx
B 4 4 2T Tnstaller exe

GCCAASTL Drawll gms

GOCAASIL Drawl? gms

GOCAASTL Drawl3 gms

GCCAASTI Drawld gms

GCCAASTT Drawl5 . gms

2. Press the “Install” button to begin installing GCC AASII CoreIDRAW VBA.

# GCC AASIT Installex

YWelcome to the installer for AAS Il VBA on
CorelDRAW version 11121314 15 and
Adobe lllustrator CS3 CS4 CS5

It is strongly recommended that you exit

CorelDRAW and lllustrator program
before continuing

Exit

CorelDRAW Plug-In A-3
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User Instructions

1. Run CorelDRAW to edit your graphics and select all images at once when you wish to
plot.

CoreIDRAW 12 - [E:\Demo\CoreIDRAW 1214AS II Demo(Tommy).cds]

‘,-i File Edit ¥iew Layout Amenge  Effects Bitmaps Text Tools  Window  Help = Fx

|2tpekacare s seae  [pENe 1 o]|al
[coon ] Bimom s () 2wt [ivers v | @ 2stm 3] geEm 2 i

@@@&ll‘(@@!ﬁ‘vﬂv ﬁlmn% ~
% 300 ZE‘I[I 1[II[I ﬂ‘ 100 ZE‘I[I 3[II[I 4[|I[I E[‘I[I E[‘I[I 7[II[I B[II[I EE‘I[I lﬂ‘ﬂﬂ :lll[l[l 12|[I[I mlll\r‘neters
= F]
“ =
G ~

.

L
)

A

)
£
.k =
EIN + 1of1  + W Pagel (& Er]

& ><

(1084.977, -116.650 ) Next click for Drag/scals; Second click for Rotatsjskew; Dbl-clicking tool selects al abjects; Shift+click mult-selects; Ak+click digs U]

2. Select “Tools->Visual Basic>Play”.

(] CoreIDRAW 12 - [D:\#5 ¥\ coreldwar?BE\A ASmulticopy.cdr]
B File  Edit View  Layout  Amsnge  Effects  Bitmaps  Text

D@@&|§<|ﬁ%|&"'ﬁj' ﬁ]@|ﬂ,vﬁ| 100%

Window  Help

2= Options... Ctlt]
B Customization. .

Serapbook 3 Steps:

Custom A4 IE | ||||%l| Units: | millimeters g: Color Management... g | rﬁ 'EI |iE|’IE |B§| ]:ﬂ_| E:
=, g i 20 300 00 B @ Save Settings As Default aa0 100 il meters
[k (o] Object Mapager ~

‘&A g_ Object Data Manager ﬂ E
2, ] Visw Menager CHl+F2 ——
Q‘ ] Link Manager OTa
Ef = Tndo Docker

= @ In:
q Internet Bookmark Manager

b O 8

O‘ Y > &'h Color Stvles

2] ") | o .
e N "' N Grophic and TeutStylss  CrleFs

d . -
/ h Fo

B, 4

Al .
@|"
@,
2. |=]
Visval Basic Editor..  AIWF11
@ Security...
& 4dd-in Manager...
Add-jns »
[ T
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The Visual Basic for Applications Marcos window will pop up.
Select GCC_CorelDraw_AASII (GCCAASII_Drawl12.gms) under the “Macros in” manual, and

press “Run”.

Macro name:

SNCE]

Macroz in | VBAPIOject

[ egcription:

<A1 Standard Frojects

=
i

3. Click on “Apply” and select whether you would like to add the registration marks by page
size or by object.

AAS II Reg. Mark Setting X
W Add Registration Mark by page size Note: “Add Registration Mark by Object” will be the default
[ Add Registration Mark by Object selection if you click on the image whereas “Add Registration

o

Length 5 i
Thickness 1 mm
Margin 0 mim

X Step S0 .

Y Skep =uln] i

~

Mo. of ¥ Copies |
Mo, of ¥ Copies |

[ Copies with outline

Apply | Zancel ‘

Mark by page size” will be the default one when the blank
area on the page is clicked.

4. Now you can print out the image file with registration marks.

CorelDRAW Plug-In
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Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”,

your registration marks will be created automatically.

Note:
1. The length setting will be in the range of 5-25mm
according to your page size.

2. Please DO NOT make any changes to the “Origin”
section when you choose to add registration marks by
page size as indicated below otherwise the position of
the marks will be changed.

[#- Workspace Rulers
(= Dacument
General Hudge
Page Size || [—]
: 0,254 - - U
Layout Mudge: i s | Super nudge | > | % 0,254 mm
Label Micro nudge: 0,254 mm | ‘2 = ‘
Background =
- Guidelines [#]5ame units For Duplicats distance, Mudge and Rulsrs
Grid .
Rulers Hiits J— .
Styles Harizankal: | millimeters |
Save ]
Export HTML
- Global [¥]5ame units For Horizontal and Yertical rulers
Crigin Tick divisions:
: Ik e 1 .
Harizankal: |U‘U :J millimeters ‘iz.‘ per tick
Wertical: ED‘D & ] millimeters [Ishow Fractions
Show Rulers Edit Scale...
[ [s]4 ] [ Cancel ] [ Help ]

The system will create the 4 marks on the 4 corners of the page as shown in the picture below

wherever you move your image.

B Be Bl Yer Locst lowp Bk Baege Ded Dbk Tk Hwlee B
Py FeE [ow v Sty o+ §

[ = "I K H-

¥
Sm..mu..mnu--. <
& X

$12:222, 3064} Mt ek o DengiScnle; b, o 3 Bk

AAZ II Reg. Mark Sethng

Iv add Registration Mark by page size

I™ &dd Registration Mark by Object

o

Length 5 i
Thickness 1 mm
Margin 0 mim

X Step S0 .

Y Skep =uln] i

~

Mo. of ¥ Copies |
Mo, of ¥ Copies |

[ Copies with outline

Apply | Zancel

X]
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Add Registration Mark by Object

AAS IT Reg. Mark Sething

[ &dd Reqistration Mark by page size

[v &dd Registration Mark by Object

* 4-Paink Position

Length p5 MM
Thickness 1 i
Matgin 0 mm

Segmental Positioning
# Sk
0| 500

'T'StE-'D ca0 -

IMulkiple Copigs

Mo. of » Copies | 4
Mo. of ¥ Copies | 4

[ Copies with outline

Apply ‘ Cancel

3

If you tick “Add Registration Mark by Object”, you will be offered three options of registration
marks as shown below.

4-Point Positioning
® Length: The length of marks
- Range: 5mm~50mm
- Optimized Setting: 25mm
®  Thickness: The line thickness of marks
- Range: Imm~2mm
- Optimized Setting: 1mm
®  Margin: The distance between marks and images
- Range: Omm~50mm

- Optimized Setting: 5mm

Segmental Positioning
® X Step: The distance of intermediate position on the X axis
® Y Step: The distance of intermediate position on the Y axis
- Range: 200mm~600mm
- Optimized Setting: Less than 500mm

Multiple Copies

® No. of X Copies: The numbers of copies on X axis

® No. of Y Copies: The numbers of copies on Y axis
- Range: 1~50. (The more copies you make, the more time
is needed for data transmission.)
- Numbers of X Copies * Numbers of Y Copies = The total
amount of image copies

®  Copies with outline: To show outlines of image graphics

Note: The values entered in the “4-Point Positioning” section (length, thickness and margin) will
still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

CorelDRAW Plug-In
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4-Point Positioning

AAS 11 Reg. Mark Setting 3

4-Point Positioning

[ Add Reqistration Mark by page size PY Length: The Iength of marks

[¥ add Reqistration Mark by Object
- Range: 5mm~50mm

{* 4-Point Position

Lenagth o5 M
Thickness 1 mm
Margin 0 T

" Segmental Positioning

- Optimized Setting: 25mm

A 4

) Thickness: The line thickness of marks

- Range: 1Imm~2mm

- Optimized Setting: 1mm

‘s ® Margin: The distance between marks and images
EP| Soo
o > Range: Omm~50mm

Y Step 500 - L i
- Optimized Setting: 5mm

" Multiple Copies

Mo, of ¥ Copies [ 4
Mo, of ¥ Copies [ 4

I Copies with outline

Apply | Cancel ‘

The system will create the 4 marks as shown in the picture below.

File Edit ¥iew Layout fmenge Effects  Bitmeps Text Table Tools Window  Help - 8 x
Rl =N BE b - & 2 o- & [wes w| snapto - &
O[1,000.0mm v @ - . = T, |6.35 mm wa ‘R
. its: | riill 40| 2,54 mm
Custom 3 Senom wa | Jog | Units: | milimeters v | | =R ] 5 35 mrn —
RN ' [ 100 200 00 400 500 6000 0 400 00 1000 millmeters | contaur » a x|
B8 walfnnnanann [lannonnnns [lhnnnnanan [fhnnnnacan [fhnnannans [[hnnannans [[hnnannann [lhnnananan ltanhananan lthnnnnanan llhnnnnnnnn flinannnans [lh2 wan »
] -~ o
d LEE
fw, =E 22X
.ﬁn _ ) To center E
=y 8_ (3 Inside i
+ | =7
ey ] O Outside I3?
= et Offset:|2.0 = |mm "
. 7 St 1 A
- E Eps: - o
Q.| ! s %
O &
Gl m
=] [l
=F 5 E.
N “E
Tﬁ. E o]
22 T £
AR | e £
Al N ) T
A | / -
4 Q
é‘, —‘ ?
@* ] E
“| ]
g
£7 v v
FB M 4 1oft kM E| Pagel 3 e 7

(<] ‘_;«
LK

(726,172, -124.719 )  Mext click for Drag/Scale; Second click for Rotate)Skew; Dbl-clicking tool selects all objects; Shift+dick multi-selects; Alk+click digs
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

- B = '

e

Area to be cut

;ﬁ:\\(g )

25mm
Page size Suggested mark length
(unit: inch) (unit: mm)
A6 (4.13 x 5.83) 5
A5 (5.83 x 8.27) 8
A4 (8.27 x 11.69) 11
A3 (11.69 x 16.54) 16
A2 (16.54 x 23.39) 23
Al (23.39 x 33.11) and above 25%

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the
previous setting will be applied.

CorelDRAW Plug-In A-3
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Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental

I Add Regration Mark by page size image to increase cutting accuracy.

IV Add Registration Mark by Object
" 4-Paint Pasition
Length ,? mmrm
Thickness ’1— i
CE o Segmental Positioning

+ Segmental Positioning PY

%Step| sng b

¥ 3tep| apg -

- Range: 200mm~600mm

X Step: The distance of intermediate position on the X axis

® Y Step: The distance of intermediate position on the Y axis

WIS - Optimized Setting: Less than 500mm

Mo, of & Copies |
Mo, of ¥ Copies |

I Copies with autline

Apply ‘ Cancel ‘

The system will create the as shown in the picture below

a File Edit ¥iew Layout Amenge  Effects  Bitmaps Text  Table Tools  Window  Help

-y B 6 - G - [ ] s - &

: Of3,4000mm v . 5 /5.0 mm EE
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""" % 0 500 1000 1500 E 2500 3000 millivieters | Contour
Ci'. ~

1500 ,

1000 ,

500
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FEM 4 1of1 b M E| Pagel

|~

(2,140,262, 1,710.... Mext click for DragfScale; Second click For RotatefSkew; Dbl-clicking tool selects all objects; Shift+click multi-selects; alt+click digs
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X

Positioning” when you are working on an extra long or large-sized

[

¥
»
*

rezereyg ey, [0 saigeen o men [l % mopey [E] 7= &, | e a0 ol
=<ENN TN RN N [ [ [T -

CorelDRAW Plug-In A-3



GCC.. Jaguar IV User Manual

Multiple Copies
It is suggested to select “Multiple Copies” when you would like to make several copies of one
image on your material to increase cutting accuracy.

[ add Reqistration Mark by page size
v Add Reqistration Mark by Object

™ 4-Point Position

Length 25 MM
Thickness [} mm Multiple Copies

Merain 0k ® No. of X Copies: The numbers of copies on X axis

™ Segmental Positioning

® No. of Y Copies: The numbers of copies on Y axis

HER] 500 oy - Range: 1~50. (The more copies you make, the more time is needed

' Step ..
=00 o for data transmission.)

@ Multiple Copies - Numbers of X Copies * Numbers of Y Copies = The total amount of
s, &% Gantes | > image copies
Mo, of ¥ Copies . . . . . .
3 ® Copies with outline : To show outlines of image graphics
[ Copies with outline

Apply ‘ Cancel ‘

The system will create the as shown in the picture below.
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Contour cutting through CorelDraw

Step 1. Position the paper with registration marks printed by your printer on the GCC cutter.
Step 2: Select “Files>Print”.
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Docurment color profiles: RGE: sRGE [EC61966-2.1; CMYK: Japan Color 2001 Coated; Grayscale: Dot Gain 15% » Q .

Please note that if you use CorelDraw X5, you must follow the steps below.
Click the “color” page and go to the “Color conversions performed by:” and then select the
model name of you cutter.
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Step 3: Click “Print”.

You can also add a Hot Icon for the AAS Il Plug-in

Step 1. Select “Tools—>Customization>Commands->Macros”.
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= Workspace
- (reneral
- Display
- Edit
- Bmap to Objects

[ ..
[+ Toalbax
[ Customization

|- Docoment
- 3labal

User Menus

All (Show All Tems)
Tools

Layout

Skatus Bar

Text

Menu Bar {File Mode)
Menu Bar (Mormal Mode)

Step 2: Choose [ GCC_CorelDraw_AASII.GCCModule.GCC_AASII] and drag it to the
“commands” bar.

Step 3: If you want to have a different icon, select “Tools->Customization>Commands—>
Appearance” to import a graphics for use as the icon. Choose an icon and press OK to
complete this setting.

CorelDRAW Plug-In
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SignPal 8.5 Instruction

The new SignPal 8.5 Software is Windows Vista compatible and the SignPal Expert above
versions support the AAS Il contour cutting function of Jaguar IV and Puma IlI cutting plotters.

Different to the previous SignPal 7.6 version, the SignPal 8.5 doesn’'t come with a keypro
dongle, which is replaced by a softkey to simplify the installation procedure. However, please
note that the system must be connected to the Internet when launching the SignPal 8.5
software for the first time with softkey. Internet access is required for online validation during the
initial installation and for future online validations every 30 days. If the softkey is unable to
connect to the Internet within a 30 day period, you will receive a message alerting you that you
can only continue working with the software for another 10 days without connecting to the
Internet.

For users without Internet or broadband connection, please contact your local distributor to
purchase hard keys (keypro dongle) and provide them your softkey ID & password for
replacement. Your original softkey ID & password will be invalid after replacement, and the new
hard key ID & password can work only with the dongle inserted to your computer. Please note
that the softkey and hard key has different user ID number as following:

Soft key IDs are 9xxxxx

Hard key IDs are 5xxxxx

SignPal 8.5 Instruction Index:

[1] Installing the SignPal 8.5 software.......................... P.01
[2] Set up your GCC Cutter on Production Manager....... P.10

-- SignPal AAS 1l Quick Start..............coiiiiiinns P.13
[3] Transferring a Software License Using Softkey......... P.18
[4] SignPal 8.5 Feature Lists............cccoviiiiiiiiniin. P.20

[1] Installing the SignPal 8.5 software

To install the software, you must have Administrator privileges. To use the software, you must
have Administrator or Power User privileges. See your Windows user guide for more
information.

1. Uninstall any previous version of the software.
2. Insert the Installation DVD.
3. Select a language and click OK.

SignPal 8.5 Instruction A-4 o 1
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4. Click Next.

GCC Production Suite [z|

Welcome to the Install5Shield Wizard for GCC
- Production Suite

The InstallShieldR ‘wizard will install GCC Production Suite
on your computer, To continue, click Mest,

< Back M et > Cancel

5. Read the Software License Agreement and select | accept the terms of the license
agreement and click Next to accept.

GCC Production Suite

License Agreement
Pleaze read the following license agreement carefully.

SOFTWARE LICEMNSE AGREEMENT

][

Thiz iz a legal agreement between you, the end uzer [either an individual or an entity], and
S4 International, Inc. [f you do not agree with the following, vou should promptly returm
the package. Uze of thiz program indicates your acceptance of the terms and conditions
stated below.

The enclosed computer program "Software iz icensed, not sold, to pou by S4

|nternational, Inc., for uze on a non-excluzive, non-transferable bagiz, anly under the
following terms, and 54 Intermational, Inc., reserves any rights not expreszsly granted to

wou. 'gel may not dizcloze to any third party any confidential information concerning the
Softwdie or 54 Intermational, Inc. or uze such confidential information ko the detiment of 4

(%) ' accept the terms of the license agreement

{1 | do not accept the termsz of the license agreement

< Back " M et > Cancel

SignPal 8.5 Instruction A-4 o 2
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6. If you did not have any previous versions of the software installed, skip to the next step. If
you still have a previous version of the software installed, you will be prompted to overwrite
the existing installation. Click Yes to overwrite any previous installation of the software.

‘.t‘)‘ A presvious installation has been debected, Would you ke to overwribe this installation?

b

Lve J[ m |

7. Select the features of the software that you want to install and click Next:

e Check GCC Production Suite to install the software.

o Check Samples to install sample files.

o Check SafeNet Sentinel System Driver to install the software driver for this key. If you
do not use this type of key, you do not need to install this driver.

GCC Production Suite

Select Features

Select the features setup will install

Select the features you want ta inztall, and deszelect the features pou do nat wank o ingtall.

1 ICC Profiles [size will wam] 0k
| SafeMet Sentingl System Driver 7.4.0 0k

Deztination Folder

£:\Program Files\GECAGCE Production Suits

Space Bequired on C: A04000 K,

Space Available on C: 27ER23E K

[ Mest > [ Cancel ]

A. To change the default destination folder, click Browse and choose a new destination
folder.
B. To check that the drive you are installing to has enough space for the installation:
a. Click Disk Space.

SignPal 8.5 Instruction A-4 °
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b. From the drop-down menu, select the drive you want to install to, and verify that it

has enough space for the installation.
c. Click OK. The installation drive changes to the selected drive when you click OK.

8. Select the Program folder where the shortcut for the software will appear. A new folder is

automatically created for the product.

9. Click Next to install the software.

GCC Production Suite

Select Program Folder
Fleaze select a program folder.

Setup will add program icons to the Program Folder listed below. ou may twpe a new folder
name, or select one from the exizhing folders list. Click Mest to continue.

Froaram Folder:

GCC Production Suite

Exizting Falders:

>

Adrinigtrative Toolz
Codetd eter
ColorPRIMT Server
Carmpatibility
EazpSIGM Wa
Games

ticrozoft Office
PosterPrint 12

£

< Back " MHext > Cancel ]

GCC Production Suite

Setup Status

GLC Production Suite iz configunng yaur new software installation,

|nztalling

Cancel

SignPal 8.5 Instruction A-4 °
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10.0Once the installer is finished installing, the Install Manager opens. The Install Manager
allows you to run a demo version of any available products, or to enter a password to access
the software and any optional features.

11.Do one of the following:

e« Check Run in demo mode to run a demo version of any available products in any

available language.

o Enter a Password, and then select a product from the Product list and a language from
the Language list. Use the Add button to enter any additional passwords in the Optional
Password section to unlock optional features.

Password

Optional Password

Install Manager

Product Selection
Enter vour password,

Then choose your product and language,

This is your main application password for the software.

If you purchased additional options, you may enter the
option passwords in this field to upgrade your software.

M

[ in demo mode

Iser Mumber

Passward

vt 10t L7 LI 7Y UP-VRGF

Optional Password

b

Produck

Language

SignPal Expert &.5w1

j |English

12.Click Done.

SignPal 8.5 Instruction
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Install Manager

Install: SignPal Expert 3,541 (English)?

|v Install ko deskkop
=

=D

13. Check which icons and preferences you want to install:

o Check Install to desktop to install a shortcut for the software on the desktop.

o Check Install to startup items to install a shortcut for the software in the Startup folder
of the Start menu. If this is done, each time the computer starts up, the software will
automatically start up and minimize itself, displaying an icon in the system tray of the
Windows system tray.

e Check Clear Application's previous preferences to clear the preferences or clear the
check box to retain old preferences.

o Click OK.

GCC Production Suite

InstallShield Wizard Complete
]

GCC Production Suite haz been successfully installed. Click
Finizh to exit the wizard.

< Back Cancel

SignPal 8.5 Instruction A-4 °
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14.Open SignPal 8.5v1

Registration

Product Registration

Registration is required to use this software

Thanks For choosing:
signPal Expert 8.5v1

Please take a moment to register your software,

Mexk Cancel

15. As you have not registered before, please check on the box at bottom to register a new
account.

i

Registration

If you have previously registered with SAi, please enter your Registration ID.

Reqgistration ID: I

¥ 1 do not have a registration ID}

carcl_|

16. Input your personal information to complete the online registration.

SignPal 8.5 Instruction A-4 o 7
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"

Registration

Registration Information
*Indicates required fields

*Country/Territory: |Mil=Eelis -

L ast Mame *First Name: I

Title *Company: I

3
3
*Address Line 1: I
3

Address Line 2 *City:

State Province Region: I.ﬁ.]abama LI *Fip/Postal Code: I

*Fhone: I Fa: I

*Email: I

Qutput Devices:

oK I Cancel |

17.1f you have registered before, please enter your Registration code as below to open SignPal
8.5v1 software.

Registration

If wou have previously registered with S8, please enker your Reqistration I0,

Reqistration I0: E_ﬂJTE

[ Idonot have a registration ID

cancel_|

SignPal 8.5 Instruction A-4 ® 3
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&)

SignPal

[Sign Making

SignPal Expert E|

i :| SignPal Expert 8,5v1

Funtime hours unkil password expires; 562,51

Licensed fx e
W He-JOMP WP I-TRY A -EYLIP-YRGE

<" SignPal Expert - [Untitled 1]
File Edit View Arrange Text Effects Bitmap

DR R 2 LB

mn e BES QN

0 70 Dent\meters{
| | 1 | | | 1 | 1 | | | 1
w Eadl
2 —;
Tip of the Day B‘

Did you know...

Fonts that you have used in a document are listed at the
top of the font list for easy access.

EOCINwOSS )
RELLHLP P M

o
L ¥ Show tips at startup < Back Hext | Clase I
o] <
| - &
) A > |
For Help, press F1 Stroke |1 Fil I f-ﬂ
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[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 8.5v1
2. Choose and set up your GCC cutter.

(Note that AAS Il System only works on Jaguar IV and Puma lll.)

Add Setup .

-~ Chooze a device

T hat is the brand name of wour vinyl cutter?

(e |
That iz the model name of your GCC?

|3CC Cutter |

SignPal Jagmar IT1-101 ~

SignPal Jaguar [11-132
SignPal Jagmar [11-183
SignFal Jaguar [11-61
SienPal Jagmar IT1-

al
SignPal Jaguar [V-183
SignPal Jagmar IV-61
SignPal Jaguar JII-1013
SignPal Jagmar JII-1323
SignFal Jaguar 1I-61
SignPal Jagmar JI-T63
SignPal Jaguar JR-1013
SignPal Jagmar JR-1323
BignPal Jaguar JR-61 M

[ F—#a- | [

“What do you want ta call your new setup?

|SignF'aI Jaguar V132

How iz pour SignPal Jaguar %-132 connected bo pour computer?
b —

< Back, [ Finish l Cancel

SignPal 8.5 Instruction A-4
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% Production Manager

- BX

File Edit Setup Wiew Help
] {-—u.

'|;|r|F'aI Jaguar I¥-132
- SignPal Jaguar Iv-132

= RAM Free: 4194 MB
= RAM Total: 1.00 GB

Whi Free: 1.82 GB
Whi Total:2.00 B

@

Job Mame

Status

C: Free: 2.01 GB
C: Total: 16.6 =B

|%e

[: Free: 6.22 GB
[: Total: 45.2 B

i J SignPal Expert 8.5w1

Runtime hours until password expires: 532,16

STEV7-KYUP-YRGF

& SiznPal Expert - [Untitled 2]
@ S Edit  Wiew Arrange Text Effects Bitmap Window Help

T
L
]« I T . o

Changes the printer and printing options

| Advanced... >

[y hew .Ct.rH-—N.j' B s MY i i | e g |
| | open. o Ao o BES QAR
| Clase ChrF4 ;'2|D ; llF : BF ; i c'iarit'i'hiét'er's;
N. ﬁ’Eind File... De i x I
T Hgave Chrl+5
S-QSave 5. Ctrl+Shift+5 =
[ Byimport... =
i) Export...
7B E@] /58 400em =
Acquire Image 3
e i[5
| EmDocument Setup... Chrl+E
Send Email 3
Workgpate 2 Sold fil -
Black.
Exit alb4F4 lil:]
I wireframe it

SignPal 8.5 Instruction
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4. Select the printer and paper size.

Print Setup

- Printer

M arme: 1'&"-.5 co2HP Lazer)et 2100 EN ‘ - Properties. .. |

Status: Ready

Type: HF Lazerlet 5100 PCL &
Where:  AF48EE—ER

Comment;  4F $#HE—5E

— Paper i~ Orientation
Size: 1.-’-‘-.4 LJ {* Poitrait
Source; ]gﬁlﬁg}% _v_j éhl " Landscape
Help J M etwark... ‘ k. Cancel
& SignPal Expert - [Untitled 2] [Z]IEIE’]
@ File Edit “iew Arrange Text Effects Bitmap MWindow Help =1 x
B e @IOQE
10 15 20 ID : centqnl'ueters
Al
=21 000em —=
F]/29700cm
EE—:
z #& leﬂ
E | Solid il |
0] Black
. [~
I Wireframe
:D_' :
< | ﬁL_E'_J >
(kIS NEE BT EEE EE IIDIIIIIDq e
{34491, 17.243) SrORE =] T -
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-- SignPal AASII Quick Start

5. Use the Rectangle Tool to create a rectangle.

& SignPal Expert - [Untitled 2] EEX
@ File Edit Wiew Arrange Text Effects Bitmap Window Help ) Ly .X_
DEEdRRea T Ll HhB = ool @ i
| e e i
T Q E |
5-@ @5&_ 3028 =
sl Off2804em =
$. [ Founded =
2 R| \ T
G Q _____ ‘ I~ Inner barder
el o 3
mARV s
uulily -
i &7
E [alict il -
] Black
E .~
I ‘ireframe
e | | s
_iii.ﬂIZIIID..-DIDDDIIBDIDIIIIIDH I Overprint o
{ 11.329, 16.609) T il

6. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window.

& SienPal Expert - [Untitled 2] H[=1ET]
@ File Edit Wiew Arrange Text Effects Bitmap Window Help ) Ly .X_
DAHBRRSFPIL DR BRSO AN
k‘l - ..ﬁ.t'j ....?,...l.‘..?....|....1ID..‘.|....1\5....|.‘..ZID....l....ZIS....I....SID...E.l.Cfaf]t.inln?ti._Si
T &
B [A = T
Q) 4 [ 000em =
$ @ o] 4+ 13000cm -
Z Q- ﬁi} =
D& I~ with s
iR \ T
. el :
I Al
1 [soiam <]
] Black
; -]
[ Wireframe
e | oo | (|3
_iii.ﬂIZIIIDIIIDIDDDIIBDIDIIIIIDH I Overprint o
{ 31606, 11.613) T T
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7. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

& SignPal Expert - [Untitled 2]

Q File Edit “iew Arrange Text NEi=WeM Bitmap  Window Help AW (1Y e
» Combine * o
[ @ H % E@ % [ Qutie. . D Q. S | C%' @ﬁ ﬁ
k Q‘nﬂn ontourCut... .|....2|D....|.... i) : Illlllcfef‘tli"?"jt?'ls'
] our Cuk Mark. ., — i
T Q ] | Dghadow... _@
] 0 Clear Contour Cut
5@ @: &_ g‘lSeparate Cankour Cuk JEontour jv
= ] FMem =
e @ =
= —
2R ' ' + [mten =
= & J P -
:_5 Qh : 5 I with holes
0: 7 1™
5 ®|7|
E Solid fil -
Ln_: Black
; [~
: I ‘Wirsframe
o -
1< Advanced... F:
ﬂjJIZIIIDDII[]DIDDDI[Z]DDIDI!I.ID* ™ Overpint
Creates cut marks around contour cut objects

8. Select “GCC AASII” in SignPal DesignCentral window to create the AAS Il registration marks
(4-Point Positioning). Set the vales as 0.1cm or above and click ‘Apply’ in DesignCentral
window. The value is to define the distance between registration marks and image area. If the
value is less than 0.1cm, it is likely that the image will overlap the marks and result in bad
cutting quality.

n N

N\

BRI R

9. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please select “GCC

SignPal 8.5 Instruction A-4 e 14
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Segmentation” in DesignCentral window and then click ‘Apply’.

10. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple Copies’
function is only available under CorelDRAW plug-in.

11. Select File > Print to print out the image.

& SignPal Expert - [Untitled 2] M=1E3
g X

518 Edit View Arrange Text Effects EBitmap  ‘Window Help

B Ctrkh | == =
@g::n Ct:I:O Ei tx % Eﬁ ) TR P o @ !E Qﬁ
' I 15 25 i

Close Chrl-+F4 L a 5 .jID. » |. Ic':arlit;i'ni'n?t'nlarls:
N ﬁ:ﬁind Fie... esignCentral Il ) [RE
I—[ [Faave Chrl+5 IH-]G i) I
SE g 5ave fs... ChrHShift+5 —
[ & Import... - LDJM c
ji RYExport... _| i TrTE—
Acquire Irnage 3
E. Em Document Setup. . Chrl+B -
E ? Cuk/Flak. .. Chrl+HL
& Cut Contour.., J _>_<~Jﬂ l

g Print Setup..., iCtrI+ShiFt+P (-

Send Email »

Waorkspace 3 Mo il =
Exit Alb-+F4

A ,

5
iiLﬂIZIIIDQIIIDIDDDII[JDIDIIIIID‘ ™ Dverprint
Prints the active document SEroRe =1 rm
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SignPal Expert

| "_». Printer paper orientation does not match document, Adjust printer autcmatically?
-

Yes Mo ‘

12. Set the Scale as 100cm =1m (100%) in Print page.

Frirter Preview
Mame:  |\\Goo2sHP Laserlet 2100 EN ~|  Propeties..
Status: Feady

Type: HF Lazerlet 5100 PCL &
PostSeript data: (7 Binary % ASCHI

Copies Frint O phiotis
Murnber of copies: 3: [ Selection only

i e | | P ]

[ Wireframe

~
I Subshate I

Scale .

(" Fit drawing to paper I Guides -

[ Grid R o

(™ Fit border to paper
P I~ Template | |

[i00em=Tmi00%)  +] [ SeleetTengiat |

Tiling Pazition
[ Print tiled pages ]Center L]

Overlap: Jor 5

P Offsets: |00 —
Advanced Offeet lﬁ
¥ Use device marging : -
I+ |gnare overprirt

Ok | Cancel

13. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You can
preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut Contour
window. The Production Manager will be automatic activated to complete the job.
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& SignPal Expert - [Untitled 2] LEX

@ File Edit View Arrange Text Effects Bitmap ‘Window Help = |& xr

DEHBRRSTI LA R0 BESARE
E ? | ? | 1 1P | 1‘5 L& 5 '?;"D |. c'emti'nlne'iers_

”‘
J<,

25
i

20
[

Select a Production Manager E'

EERLEICE
RELPHPP P
B

[ = i
e 3 |— * On this computer [Local)

b " On another computer [Metwark]

e " On the intemet address:

e ‘ 2 oK, Cancel
< UEEE OO OSSOSO ORI o FHRE
Far Help, press F1 7 5

“# Cut Contour

SignPalJaguar W-132@GCC J5E 000 = | | Job Status |

Properties... zj

General ] fptions | Advanced |

ralerial
el 130,120 110,100 90 50 70 60 50 40 30 20 410 0f -
52000 % 1962 ﬂ

|40 [sS720en =

L 1]

Send now -

- Position =
T
2 Fowen =
T

-~ Size

(10,20 |30 40 50 60 70 80 90 100,110,°20,130,140, 150,160,170, 180,190,200, 210,22

P

W )|y | & - Cantour Cut ‘Send | Done J

0,0
4
4
1
1
4
14
4
1
1
-
.
2 -
‘
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[3] Transferring a Software License Using Softkey

Softkey allows you to transfer the software license to another computer by disabling the
software license on one computer, and enabling it on another.

Remarks: If you would like to upgrade or reinstall the Windows OS, please transfer your
license before reinstallation. If your hard drive has been formatted and you forget to transfer
license in advance, please provide your SignPal ID and password to your local distributor,
they will contact GCC to reset your data, and you will be able to register again afterward.

1. From the Help menu, mouse over Registration and select Transfer License.

& SignPal Expert - [Untitled 1]
@ File Edit “iew Arrange Text Effects Bitmap ‘Window BgE

B ﬁ% [‘a ﬁ E@ E ?Tu:lnié'ti-.edav... FI% Qﬁ

10 50 Help Topics

ok |

k‘ﬂm L L o e e e

" Zheck for Software Updates
T Q ﬂF‘@gister online. ..

%‘ @ . ? About

Ly I 1 |
Edit Reqgistration

2. Click Yes to deactivate the software license on the computer currently running the software.
You can reactivate the license on another computer or the same computer.

Transfer License

This will deackivate wour copy of SignPal Expert 8,51 allawing activation on another computer ar reactivation of this copy,

Continuey
Yes ‘ Mo |

3. Make note of your Registration ID and click OK.

Transfer License

Your license is ready ko be installed on another computer,
Please write down ywour regstration number FQL.HJTB.

You can use this code to skip the reqistration step when re-activating or re-installing the software,

[« 4
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4. Install the software on the computer you wish to transfer the license to.

Registration

Product Registration

Reqgistration is required to use this software

Thanks for choosing:
SignPal Expert 8.5v1

Flease take a moment to reqgister vour software,

Cancel I

Registration

If wou have previously registered with Sai, please enker your Reqistration 10,

R.eqistration IC: mJTE I i

[ Idonot have a registration 1D

—
i

Ok, Cancel

SignPal 8.5 Instruction A-4 ® 19
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[4] SignPal 8.5 Feature Lists

Pro

Master

Expert

Apprentice

Working with Files

Job Info

Templates

Using DesignEditor

DesignEditor

Arranging Objects

Distribute

Working with Color

Eyedropper

Using Fill/Stroke Editor

Overprint

Working with Shapes

Fan

Arrow

Working with Text

Text Block Size

URW Font Support

Optional

Working with Bitmaps

Scanning

Rasterize

Colormode

Marquee

Move

Eraser

Pencil

Fill

Crop

AutoTrace

ColorTrace

Working with Effects

Color Trapping

Graphic Styles

Contour

Working with Measurements and Labels

Dimensions / Labels

Automatic Dimension

Dimension to Page

Cutting your Design

Cut/Plot

SignPal 8.5 Instruction
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EasySIGN Instruction

The user manual of EasySIGN software is available on the EasySIGN program CD, or you can
refer to the getting started manual available on the EasySIGN webpage at
http://www.easysign.com/mainwebv1l/DownGT.aspx.

GCC AASII Corpmark System

This application note will show you how to use the GCC AASII corpmark system. It assumes
that you have installed your GCC plotter correctly, and that you are able to cut simple jobs on it.
If not, please refer to the “Getting started” manual available through the menu "Help, Various,
GettingStarted.pdf".

1. Make or import a design

You can either make the design in EasySIGN or import an
existing design from another application. For making the design in
EasySIGN refer to the "Getting Started" manual. To import a
design (for example an Adobe illustrator file) into EasySIGN, use
either the compatibility option, or use direct import (menu : "File,
Import"). The easiest way is to use compatibility. To do this, start
EasySIGN, then use the menu “File, Compatibility”, and click the
software of your choice.

Export cutable only

Export to EasySIGN

This software will now start, and can be used to design or open
the required job. Click the icon in the system tray to easily send
the file into EasySIGN.

2. Create print & cut lines.

When your design is successfully imported into EasySIGN, you
should then select the line or lines that you want to cut on your
plotter. After selecting them, use the command “Edit, Convert to,
Line type, Print&cut line”. The lines that will be cut are now shown
in a dotted red line. Copy the design as you like.

EasySIGN Instruction A-5
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3. Enable the cropmarks.

Settings

I Wwithin wWindaws printer margin.

Alignment spstenn: |GEE AASIL Mulicopy

Cropmark size: 25 J mm

[ |

X Right-click on an empty part of the worksheet, and

Page | Giid | Unts | Test  Cropmarks | Color Management | choose the command “Cropmark settings”.

This will show a dialog.

Please tick the box called “Show Print & cut cropmarks”.

Next, you need to make a choice which system that you want to use, there are three different

systems:

GCC AASII

This system uses four cropmarks, and one copy. It is meant for
jobs that are not very large (like 60 cm or smaller) and that are
going to be printed on single sheets.

GCC AASII, Multicopy

Use this system when you want to cut multiple copies of a small
job. This will give you very high accuracy, but the plotter will
scan every copy of the job separately, which is of course slower
than one big job.

GCC AASII, Multisegment

Use this system when the job is large. We recommend it for
jobs bigger than 60 centimeter. It will place extra markers on the
sheet, which will enhance the accuracy but will take extra time
to scan.

The size of the cropmarks is fixed at 25 mm. Just click “OK” to close the dialog. If you have
chosen the “Multicopy” cropmarks, there will be extra settings for horizontal copies, vertical
copies etc, please ignore these for now, we will get back to them later.

EasySIGN Instruction
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4. Position the cropmark

Use the panelling tool from the left toolbox to drag the
cropmarks around your job.

Make sure that the cropmarks have some white space
J around them, there should not be any objects inside them, to
make sure they can be scanned accurately.

5. Export the job for printing

Your design is now ready for production. Click “File, Export”, and a dialog will come up that
enables you to create a file. We advise you to use “EPS Encapsulated Postscript (*.EPS)” as
the output format, this can be read by any RIP or other print software. Print the resulting EPS
file with the software of your choice.

6. Cut the result
Place the resulting print in your plotter. Set the plotter to “offline” and use the arrow keys to
position the laser within the lower right cropmark, then set the plotter to “online”.

If you have chosen the cropmarks “Multicopy”, there is one
extra step: right-click the page and go to the “Cropmark
settings” dialog again. In the dialog, enter the correct values
for “nr. Of copies horizontal”, “Nr of copies vertical” and
“Copy distance horizontal”, “copy distance vertical”, then click
“OK”.

EasySIGN Instruction A-5
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In the EasySIGN software, choose “File, Plotting”. A dialog will come up that allows you to
change the plotter settings.

Plotting El
Settings m
Device: |GCC Cutter with 24511 (General] ﬂ -

LCancel
Use Settings: |P\Ul instelingen 0 ﬂ Edit
Selection
r
™ One panel only: % 4: i 4:|
[ By Calar:
r

¥ Zlignment plotting. 2

™ Hold job in production manager.

I Johis: 3
Special lines
Line types to plat Select al
O Homal lirne
Print and cut Line Deselect al

Just make sure that the following settings are made:

Alignment plotting (1) Switched on
Normal line (2) Switched off
Print and cut line (3) Switched on

Then click “OK”. Your plotter will then start scanning the cropmarks, and after that the job will be

cut.

EasySIGN Instruction
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GreatCut Instruction

The user manual of GreatCut software is available on the GCC installation CD.

GCC AASII System
Below are step-by-step instructions when using the AAS function of GreatCut software.

Step 1 Import the image you want to print and cut.

o GreatCut - [{untitled - 1)]
)58 Edit Dedgn Vew Toole Zeftings Wmdow Help

Hew... Crl- & H D
Open... Chl-L T Relative

Lo

Import

Step 2 Add the contour line.

= GreatCut - [{umtifled - 1)]
File Edit Desien Yiew [BU

D& H A ol ootk oRO=aT
X186 65 231E u [T Relative Duplicat
1 23 . - & By we  Duplicate
v:[182 %8 fle17 SetlogMauks Shift-T " anglefJooo " [ Al
] Measime M 300 400 500 ]
Pal=|Mm} =
sra sl
Hew |5 7
&gl ] Crtline. . 8]
S _: Welding. . 1]
=HEl 3 [
Contour b_(l
Find Contour Color
b axirnum Gray Scale 97 4

Back 4 ﬂ Jﬂ Andern...
N Flizoggrrf;lt-i‘gn Tolerance: 4

[ []

Accuracy: |ver_|,| high [zlower) ﬂ

[ Keep Interiar Elements

Extended...
Cancel

Abstand und Linienfuhiung

Contour Offzet:

Corner Shape:| normal

The value of Contour Offset should be = 0.5mm.

GreatCut Instruction A-6
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Step 3 Add the registration marks
Set up the value of registration marks.

= GreatCut - [(untitled - 1)]
File Edit Desgn Yew Took B

400

DeEddLaoe Standerd Settings Miscellaneous. Cak] R
x| -] | Color Paletts ¥ JobInfo.
Working Ares. Moz, .. =
vl 150' =0 Rulers. Shift1 Output Devices. . :
Pal =| MM Litstlisiolinsaled Unitof Measmement Begister / Jog Marks,,
Hewi |5 T i N
=l 3 v Undo /Redo ShiFy | L
E v Bnap Mode P
E Choose Language...

=
ey
&

4-Point Positioning
® Size: The length of marks
- Range: 5Smm~50mm

Setup - Register / Print { Jogz Marks - Optimized Setting: 25mm
JngMarka ® Object margin: The distance
| _l between marks and images

bype |GCC (AASI) |

- Range: Omm~50mm
- Optimized Setting: 5mm

{ ke nakkasis | | ® Line thickness: the line thickness
Size 2300 mm R of marks
okject margin 500 mm [v corners tothe outer side N Range' 1mm~2mm
Lirne Thickness 1.00 [T output marks (or by pressing ot ] _. .
max. x Distance 50000 mm - Optimized Setting: 1mm
max. y Distance 50000 mm
: , : Segmental Positioning
Register Marks Print £ Cutting Marks
Size 2500 mm B ® Max. x Distance: The distance of
Cut without Cross bal o e | 2500 S intermediate position on the X axis
Offzet to Ohject [ 500 mm

- Range: 200-500 mm
Max. y Distance: The distance of

intermediate position on the Y axis

- Range: 200-500 mm

Feoresi | Line Thickness 100 mm
: o

Note:

1. Jog Marks are Registration Marks; please adjust your parameters in this section. Please DO
NOT make any changes to the “Register Marks” and “Print/Cutting Marks” sections
highlighted in yellow.

2. Three types of registration marks and the ways of setting them are introduced in the
following steps.
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4-Point Positioning
Adjust the size, object margin and line thickness of your registration marks. After this is finished,
click “Set Jog Marks” under “Tools”.

Setup - Register f Frint / Jog Marks Y Size: The Iength of marks
Jog Marks —— — -> Range: 5mm~50mm
bype |GCC (AAS 1) = - Optimized Setting: 25mm

® Object margin: The distance

between marks and images

" align to working area

— = - Range: Omm~50mm
Size 2500 mom . .g . .
ahiject margin 500 mm [ corners tothe outer side > Optlmlzed Settlng: smm
Line Thickness 100 mm | T o ing o ] Line thickness: the line

max. x Distance 0000 mm

max. y Distance 50000 mm

thickness of marks
- Range: Tmm~2mm

regsiertiars Bl At - Optimized Setting: 1Tmm
: r o= :

Size 25.00 mm

[ Cut without Cross L J Size 2500 mm

Offzet to Object 00 mm
oK | o | Line Thicknesz 100 mm

File Edit Design View Tools Settings Window Help

Dedige B S @dEFF oo ? kiR L= >
X -— mm %—'|_ [ Relative
hs b1 mm | Angle] = [ oA Apply |
Fal s mm -200 -100 [1] 100 200 300 400 00 GO0 700 H00 800 | A

400
1

300

=
200

100

A 20128 mim x H: 18619 mm, Ohbjects: 2 +++

H:670.54 ¥ 56814
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply the above function(see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

o ] » |

e
. » Area to be cut

/ ﬁ«\-\\‘b\l\q_/h/ e ~ _ s

25mm 5mm
Page size Suggested mark length
(unit: inch) (unit: mm)
A6 (4.13 x 5.83) 5
A5 (5.83 x 8.27) 8
A4 (8.27 x 11.69) 11
A3 (11.69 x 16.54) 16
A2 (16.54 x 23.39) 23
A1 (23.39 x 33.11) and above 25%

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.
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Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental Positioning” by adjusting the x
and y distance when you are working on an extra long or large-size image to increase cutting
quality.

Setnp - Regmister / Print ! Jog Marks

Jog Marks

type |GCC (ARSI |

" align to working area

Register Marks

Size 2300 mm

[ Cut without Crozs

Print £ Cutting Marks
| . |

L d Size

2500 mm
S00 mm
1.00 mm

Offzet to Ohbject

Line Thickneszs

Size 2500 mem Max. x Distance: The distance of
i i 500 i . . . .

£RsectinaEcin i eI AT intermediate position on the X axis

Line Thickness 1.00 =

. = Distarice [ 50000 mm - Range: 200-500 mm

mae. y Distance | 50000 mm v Max. y Distance: The distance of

intermediate position on the Y axis

- Range: 200-500 mm

The system will create the marks as shown in the picture below.

GreatCut - [(untitled - 1)] [WEE
File Edit Design View Tools Settings Window Help
Dedd & e B S & O Tk AR &= F
X -~ mm % — [~ Relative
~

w: b mm o — Angle: = Al Apply_|

-100 [i] 100 300 400 500 BO0 700 800 ~
Pal 5| mm

S S S S U S S S S A B S I B S AU
New|[E
el (o
Sel

® mm IE |

200 300

100

=

, Segmental Positioning

B

e+ 4TE.18 mim o H: 432,68 mm, Objects: 3 +++

H:75968 ¥:-5.11
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Multiple Copies

Setnp - Regmister / Print ! Jog Marks

Jog Marks

bype

GCC (ALS I

=

™ align to working area

—

L

When you apply the “Multiple

Size ’W mim
object margin ] 500 mm
Line Thicknesz ’_1_0_0‘ Tt
max. x Distance | 0000 mm

50000 mm

max. v Distance

Register Marks
Size

25.00 mim

[ Cut without Crozs

o]

Cancel ]

¥ corners to the outer side

[ cutput marks for by G

Print £ Cutting Marks -
| . |
L Size

Cffzet to Ohject

Line Thickneszs

2500 mm
S00 mm
1.00 mm

» Copies” function, the value that
has been set in this section will
still be applied.

Set the registration marks.

o GreatCut - [{umtitled - 1}]

File Edit Design  Yiew B0 Setting:  Wmdow Help

" ﬁ.l‘li|l: = AN

K

Y kR L=H T

& By [ Relative Duplicate

300

400 S00 o

X [186 80 230 E
v [1ez g1 QETTE| et log Marks
Pal > MM |||||:1|ETJ|||| . .
Hew [ Crptimize Blaterial .
el ] Oaflie 0
=1 3 Welding. W
& 4 |
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Select the whole image including registration marks and click the multiple copies button.

feal mititled
[ LSS s

DEHVAO 2B S « | da
x:|286.00 217 82 mm [10000 %— ® ® R
W mmm

¥: |73 08 the7es mm (10000 %— = ==
Pai »|mm g -|mu| ? 1 1':“:| 1 ?IIJ 1 I 1 | it
Hm :II 18 18 ls 18 1818 2108 18 1 als 18 1118 218 14 1 sls 189 1518 leﬁul ’2_ EE
T E
@ | =
& =
@ |53 -
B E [~ Fill Working &res
£ ﬁ:
B = [ Create Clones
| 3 ™ [ Group Result
a3 i
% |23 @ @ W Ogtimize for output
g. g . o Iebzin Direction: (EE
] @ @1 oK | Cancel |
ol - = ZANCY)
L L

- =

Note: The spacing of vertical & horizontal (Offset X & Y) should be = 20mm or = Omm.

Step 4 Print out the image.

If you apply the Multiple Copies function, you will have to set up the multiple copies function with
GCC cutting plotter by following the steps below.

*Please note that you cannot select the whole images when output the multiple copies of
images. You only need to select the contour line of original one and set up the value with
GreatCut and then you can send it to GCC cutting plotter.
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See the example as below.
Right: (You should select the contour line but not the image.)

o GreatCut - [{untitled - 1)]

Fil= Edit Design View Tools Zettings Wmdow Help
DEeddiae taBd S &l 5 © Tk &R L= T,

X: 287 00 174,30 mm (100,00 %—,-_ U & By [ Relative Duplicate
v = == p
v:[eass $[1aa01 mm 10000 %— = ®/m anglefoon " [ Al
mm =100 1] 100 200 300 400 500 BOL

Pal > polosvelovesbvovolunwiBveiolovorBiwpnlovwsbonvnlorweliorelornrBioraloroibosrnloinslingi
M -

Sel g—'
—]

:

_|
&
&
@

&>
o &
e

i
o

] Ky® Ko
Ged Geg

Wrong: (You cannot select the whole images.)

=8 GreatCut - [{untitled - 1)]

File Edit Design Yew Took Settings Wmdow Help
DEed a6 iaB S8 & & ) Pl R 0= T,

%:[428 00 =302 21 mm  [100.00 %—,-_ LUy & By [ Relative Duplicate
W = == S —
v: 9498 {154 mm [10000 %— = mm Angle: = an
=100 1] 100 200 300 400
Pal =| MM
oo Bygpnlovesbonrolosni oo iolovorboornlovesloovolornrByoiolornrBoarsloinsliornlornrlings
Hew g
Sel ﬁ_'

.l

%59 K§S
1 4 GeY
_ P@@ +@ !

: 536 K5
|| 484 Ged

E@@@@@@@@@@@@@@H
[ 1 | [ |
1
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Now you can output the image.

& GreatCut - [(untitled - 1)]
G158 Edit Design  View Tools Zettings Wmdow Help

Hew... Crl-i & H L=
Qpl!-'h... Cirl-L : Relative  Duplicate
Save Cel-3 : All Apply
Save as.. Shaft-Crel-

kgl
[mport... Sl
Export... ChlE

Chtprat...
o Cid-0)

CAProgram Files ETROEYETEM S oCut Profersonsl 434\ lobCoCuatogg

CADocument: and Sethings\jacon s\ 8 Mcotetst oo _{
CADocuments and Setingsison oS ENTES TER oo

CADocuments and Settingsscon, st fFDODFG cof @

o8 GaY

Output to device GCC Jagnar IV

Output

Device: FGO&: Jaguar IV

Mode / Tool: |Cut with AAS

Material |For = _J Copies Spacing: | 0.00 mm
Segment Spacing: | 0.00 mm
-
Parameter Wale | ¥ Sort before output
AAS Oifset Ursprung X [mm] 0.00 !
AAS Otfset Ursgrung ¥ (mm) 0.00 I Stack Processing
Pressure 15 [ wval after Segment
Speed 50 [ Reference Port
Matersal widith [mm] 206843 f
Length [mm] 35048 I~ Piot to File
Murnbar of copies in K-drection 1 Save zettings |
Anzahl der Kogien in Y Richtundg 1 '
Distance betwesn copiss [mm] 10.00 mecd
Origire |Mew origin |
Accuracy: [normal |
Read Waterial Objects: | Al cbjects -

Eraview ] Cudpnt ‘ Tosl Dirive I Carcal |

B. Select the series of cutter and the USB port.

GreatCut Instruction A-6



GCC.. Jaguar IV User Manual

Motle | Toal |Cut wih AAS

Material |Fol

Barameter

AAS Offset Ursprung X [mm]
AAS Offset Ursprung v [mm)

Preszure
Spesd
Materiad wichh [mm]
Length [mm]
Nurmber of copies in X-drection OCC hguerlV USE v
Anzahl der Kogien in Y Richtung
Distance betveen copes [mm)
TCRAR | Bot: |01
Spooler.
Fead Material Spooler | =]
oK | Cemal |
Preview | Oudput ] Test Drive I Cancel |

C. Set up the number of copies you need to cut here.

Note:

1. The number of copies and distance between copies should be the same as you made
above.

2. You should confirm that the option of objects must show “Selected objects”.

Ouiput o device GCC Jaguar IY

Output
Mumber of output: 1
Device: |GCC Jaguar IV ﬂ s p
Copies: 1
Mods ( Taok |Cut with A4S | r 0.00 mm
[~ vveed Border: m mm
iEgEE |F°" ﬂ J Copies Spacing: | 0.00 mm
Segment Spacing: 0.00 mm
-
Parameter Walue ¥ Sort before output
A85 Offset Ursprung X [mm] 0.00 .
445 Offset Ursprung ¥ [mm] 0.00 ol SR g
Pressure 15 I— Wait after Segment
Speed 50
Material wickh [mm] 208 43

[~ Plot to File

| ereth

Mumber of copies in H-direction Save settings
Anzahl der Kopien in % Richtung

yeen copies [mm]

oton [reworan ]

Read Material

Job will be segmented!

Preview | Output | Test Drive ‘ Cancel | >

N —

T

Step 5 You now have a perfectly cut image.
Enjoy!

Ohjects: | Seleted ohiects i
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| Mustrator Plug-In Instruction

AASII VBA Installer is applicable for lllustrator Version CS3, CS4, CS5

Installation

1. Check the “AAS lllustrator Installer” folder in Jaguar IV Installation CD, and double click
the “AASllInstaller.exe” file to run the installation program.

2| _AASI_Reg Mark_Setting 01_03_02 jsx
B 4 4 2T Tnstaller exe

GCCAASTL Drawll gms

GOCAASIL Drawl? gms

GOCAASTL Drawl3 gms

GCCAASTI Drawld gms

GCCAASTT Drawl5 . gms

2. Press the “Install” button to begin installing GCC AASII lllustrator VBA.

S GCC AASIT Installer

YWelcome to the installer for AAS Il VBA on
CorelDRAW version 11121314 15 and
Adobe lllustrator CS3 CS4 CS5

It is strongly recommended that you exit
CorelDRAW and lllustrator program
before continuing

E it

Illustrator Plug-In A-7
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User Instructions

1) Open lllustrator.

2) Edit your image and create a contour line (Note: you must have the line width set as
0.001mm).

ARk BIL Oue Tvoe Sekel Elfel View Wndow Heb | KE] [E - [~ R —
voshasn | /% Q0¥ ok Soms v |« 3piBk v s | gpmen we R [oscuwnisew | [ peecs | S =
sticken 111 [Conwerted | eps® § 77% (RGDPreview) X

AR, -
AR P
8T, .
N L1}
&,

& 2, o
o8, . -
) Contour line -

B, ki, W_ﬁ
] wughni |8 ez | [ ml= =

3 Mtz b g O
il FETE Ll
- Lehhwithe————————— ==
e 0
= 5 wl
=
- [N

=

L *

3) Click on the image and apply the AAS function
(File>Scripts>_AASII_Reg_Mark_Setting_01_03_02)

|Ai [Bel] Bt cbiect Twe sSelect Effest Wew widow belp | MRl [~ |Essemas ~ | [T - = %
: Hew... CMN = 8 ]
B ew trom Templae e | s v opet [0 s g By RAS Tl TS M H moke K
i Gpen Crko iew) %
COpen Recent Fiks v ~
L{. | e i Buiden. ACELO &
- i Shase My Screea.. (a
a . Dievice Central . ==
N Cloze ColW L
’d ]
& Save A Shifw s
D0 SseaCopy., AlMTEHS &
o) Sevess Templat. |
N [ I
?-l' Save for Web & Devices. . Al+ShiiHCrhS ‘l'*ﬂll "l e
@ [ — —
29 . : [ CoEE®R r
o A : “[@an ©
- Save for Microsoft Offics. . g \ [ElDashed Line 1
5 Eoat. pAe B ° ) e —
o d = =
2 GreaiCut L L\ o ji -
Cine T p— | N
N i
GbE  Document Senp. Maceny | Lo
@ (8 Document Color Mode v S::D::AWF = —
T Fielnio.. AltsShifteCrel+] e CIA ™ as 2 q
Print, Cthp _iAS] 03 02
Egit CulQ | Otherfionpt CEWFIZ
Thayer CRE ]
v
% w1 wrHE L (k3 >
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4) Select the registration marks needed
A He Fdit Object Type Select Effect View Widow Hep | Kid [HE - _Emmsw[:]-a:'
: o o ke o Bl 2 Toels TS b0 e K =

T

R %, The Mark, Satting- START 11 * &
:; ? [] 4-Pont Poiskioning | ™Y
::7' 3‘ Length{mm): 25 1z
= é? Thickness(me): 1 *
0.8, . i bl
o i Margin{mm): s Leereiill
‘Qlﬂi_ 4 STROKE _
L‘L‘H‘L‘l [] Segmental Poistioning | Weights| ]| E"—'i @
ey = "% w
LS ¥ Steplmm): 500 Emm‘.:l ita) i
54 ¥ St i 1 I 2
s plmen): ls00 poas] RO

@A s

. ! &l
il TRANSFORM [ Multiple Copies |
.|
LR s No, of X Copies: [ | Spece(mm) [p |

By PATHFINDER

.
Mo, of YCopiest |1 | [] Copies with outine
e e——————————
1 Layer o = 3 F
Execute
The AAS Registration Mark Auko-Generabon Setting - END# .
v
w Wl ai weH e Unmaniaged File (ks >

5) Three types of registration marks are introduced here: 4-Point Positioning, Segmental
Positioning and Multiple Copies.

AASII Reg. Mark Sefting Prog... 1.03-02 X

4-Paint Poisitioning |

Note:
Length(mm): The values entered in the “4-Point Positioning” section (length,
Thickness(m): thickness and margin) will still be applied when you tick
arginnm): “Segmental Positioning” or “Multiple Copies”.

[] segmental Paisitioning |

% Skep{mm): 500

¥ Skepimm): 500

[ Multiple Copies |

Mo, of ¥ Copies: Marginirm EI
Mo of ¥ Copies: [ Copies with autiine

PrOQUESSs: e e e o o o :

[ ] [ |
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6) Confirm the registration marks (the 4-Point Position mark is used as an illustration in the
following steps).

aﬁ Fle Edit Ohject Type GSelect Effect View Window Help \ Mol [WE v \ ESSENTIALS + ‘ cj - o x
oo B B2 Tl TEE M e K :

© Mixed Objects e

sticker111 [Converted].eps® @ 73% (RGB/Preview) X

Wisight
iicer Uity

align streke: £ 1 11

[E]Dashed Line

B |
te [oufl][vxm ¥

del oep dmh o dwh g

g 5 - =
| | @ || 0[] mark Layer o

ZLayers ® -a a ¥

F TRansrorm
align Objects:

BT 4w e
Distribute Ohjects:
= = = b o i

Distributs Spacing:
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7) Click on the blank area on the page and then click “Document Setup”.
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8) Hit “Edit Artboards”.
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9) Click on “Presets — Fit Artboard to Artwork bounds”.
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10) Please move your mouse to the tool bar on the left when step 10) is finished and then click

“Selection Tool”.
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11) This will take you back to the edit mode.
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12) Print out the file with the contour line and the registration marks.
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13) Place the printed file on the cutter, lower the pinch rollers and then position the carriage at
the origin of the registration marks.

14) Send the file to the cutter.
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15) Select the cutter model, position the object in the bottom left corner and then click “Print”.
.

Frint Preset: |Cust0m v| =]
Brinter:

PRD: |

General
Matks and Eleed Copies: Collate [IReverse Order
Sutpik @ Al [C1gnare Arthoards
Graphics =
Color Management Range:! l:l Skip Blank Artboards
Advanced i
Summary — Media

Sige: ‘Deﬁned by Driver v| Transyerse

width: [1200mm | Heloht: [B10mm | [|

— Options

Placemient: % 42333 mm| ¥ 1474005 n

() Do Mot Scal

()Fit to Page

Ousmecte  w 5w

OTie Full Pages Qverlap:
= I

144 1ef1 (D)

Print Layers: \Visible & Printable Layers v|

[ Pint ][ Cancel | [ Dare |

16) Your job is now completed.
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Three types of registration marks

4-Point Positioning

AASII Reg. Mark Setfing Prog... ¥1.03-02 X

4-Point Positioning

<ot e | ® Length: The length of marks
- Range: 5Smm~50mm
- Optimized Setting: 25mm

® Thickness: The line thickness of marks
- Range: Tmm~2mm

Lengthirmrn):
Thickness{mrm): l:l
Marginfmimy):

A 4

[[] Segmental Paisitioning | > Optimized Setting: Tmm
® Margin: The distance between marks and
% Step(mm): S00
images
Y Step(mm): 500
- Range: Omm~50mm
[ Mukiple Copes | - Optimized Setting: Smm

Mo, of % Copies: Marginimm): EI
Ma, af ¥ Copies: [ Copies with outline

Progress: e e e e e e e e =) }

(o ] [ |

The system will create the 4 marks as shown in the picture below.
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

B B = '

e

Area to be cut

/Q\Q/; )

25mm
Page size Suggested mark length
(unit: inch) (unit: mm)
A6 (4.13 x 5.83) 5
A5 (5.83 x 8.27) 8
A4 (8.27 x 11.69) 11
A3 (11.69 x 16.54) 16
A2 (16.54 x 23.39) 23
A1 (23.39 x 33.11) and above 25%

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.
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Segmental Positioning
For precise cutting quality, it is suggested to select “Segmental

Positioning” when you are working on an extra long or
(] 4-Paint Paistioning | large-sized image to increase cutting accuracy.

AASII Reg Mark Sething Frog  ¥1 03-02 rS—(l

Length(rnmy:
Thicknesstmm}:

Margindrmm): o .
Segmental Positioning

(7] segmental Foistioning | ® X Step: The distance of intermediate position on the X
axis
% Skep{mm): 500
5o +—> ® Y Step: The distance of intermediate position on the Y
ep(mm}: 500
axis
ATDERE - Range: 200mm~600mm

No.of X Copkss [1 | Marantomys [0 | - Optimized Setting: Less than 500mm

Mo, af ¥ Copies: l:l [ Copies with outline

ProQress: e i e i o o ' :

l Apply l [ Cancel

The system will create the marks as shown in the picture below
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Multiple Copies

AASTI Beg Mark Setting Proz... ¥1.03-02

[] 4-Paint Poisitioning .

Lengthi{mrn):
Thickness(mm}):
Margin{mm}:

[ seamental Poisitioning |

% Stepimm); 500

W Stepimm); 500

Mulkiple Copies |

It is suggested to select “Multiple Copies” when you would
like to make several copies of one image on your material to
increase cutting accuracy.

Multiple Copies
® No. of X Copies: The numbers of copies on X axis
® No. of Y Copies: The numbers of copies on Y axis
- Range: 1~50. (The more copies you make, the more
_time is needed for data transmission.)

Mo, of ¥ Copies: Marginimm): EI
Ma. of ¥ Copies: [ Copies with outline

PrOQUESS: o o o o o o o :

total amount of image copies

negative numbers allowed

Y axis

The system will create the as shown in the picture below.
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® Copies with outline : To show outlines of image graphics
® Margin: Space between marks; must be 0 or = 20, no



	00 Cover
	Jaguar IV Series
	User Manual


	00_1 Important  Info
	00_2 Table of Contents
	01 Ch1_General Info
	02 Ch2_Installation
	Step 1
	Step 2
	Step 3
	Step 4 
	Step 5
	Step 6
	Step 7
	Step 1 
	Step 4 
	Step 6 
	Step 1
	Step 2
	Step 3
	Step 5  Use the reversing steps to remove the blade holder.
	Step 6  Eject the blade. Push “Blade eject pin” to eject blade when the blade needs to be replaced.  
	Caution


	03 Ch3_The Control Panel
	04 Ch4_Operation
	Step 1
	Step 2
	Step 3
	Step 4
	Step 5
	Step 1
	Insert a roll media flange at the end of each roll 
	media and tighten the thumbscrew until the roll 
	media is firmly gripped(see Figure 4-7).
	Load the media on the platen. Please refer to “4.1.1 Loading the sheet media”.  After loading the roll media, flatten the media on the platen and hold the front edge of the roll media firmly (Figure 4-9).                                                            
	4.4   How to Cut 3mm Letters
	4.5 How to Make A Long Plot 



	05 Ch5_Accu-Aligning System
	Chapter 5 Accu-Aligning System
	Step 1 Creating Graphics
	Step 2 Placing the Registration Marks

	06 Ch6_Maintenance
	Cleaning Precaution ! 

	07 Ch7_Trouble Shooting
	08_A-1 Jagaur IV Specification
	08_A-2 Blade Specification
	About the Tool
	Protrusion Length of the Blade


	08_A-3 CorelDraw Plug-In
	08_A-4 SignPal 8.5
	[1] Installing the SignPal 8.5 software
	[4] SignPal 8.5 Feature Lists

	08_A-5 EasySIGN
	08_A-6 GreatCut
	08_A-7 Illustrator

